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FJyirtg Faders and Microsoft Windows
Flying FdddfS* Operates in a<grapNes environment called Microsoft Windows, created by Microsoft Corporation. An extension of the MS-DOS 

bpe^gting system, Microsoft Windows gives a  standard look and feel to Flying Faders and all other Windows applications.
... , ,  The Flying Faders package contains all the software necessary to run Flying £|M erai You can also run Flying Faders under Microsoft

WTridows version ZO or higher . ̂  &
W ith Microsoft Windows, you can take advantage of these additional features of the Windows environment:

* -Running multiple applications: You can run several applications under Windows at one tim e and easily switch between them, creating 
.. p  an integrated worjcjeqv^onpient

-Date ̂ c h a n g iijk w e e n  applications: You can transfer data between Flying Faders and other standard DOS applications as well as 
, .other Windows applications.

-Windows control of the DdSertvironment: From the Windows environment you can easily access all Windows and non-Windows 
' J - applications, files, directories, and disks, and control all DOS-related tasks such as directory or file management and formatting disks. 

p  J , ^  To run Flying Faders undsr Microsoft Windows, you need to license and install Microsoft Windows version 2.03 or higher.
' The abbv^tefct Is a  Mfcroecft(c) Windows licensing requirement end may be Ignored by Flying Faders users who don't wish to license 

Microsoft Windows.
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INTRODUCTION

Flying Faders was created to be as unobtrusive as possible. The 
system was designed with a human interface that allows you to 
create a mix with minimal contact with the computer. There are no 
commands to memorize, because the system is controlled by a 
pointing device and dedicated keys. The on-line help is substantial 
enough that new users can perform most functions without looking 
at the manual at all. For those of you who like to experiment first 
and read the manual later (if at all), we suggest that you at least 
read the first chapter.

Our design goal for this manual (as well as for the entire Flying 
Faders system) is to keep everything as simple and as friendly as 
possible. This isn’t the most entertaining text to read (we've edited 
out all the jokes, insults, and family vacation stories), but by using 
"minimalist” writing, we hope that this can serve as a reliable refer­
ence.

MANUAL FORMAT
With the exception of chapters 1,2, and 3, and 11, this manual uses 
the main screen menu and menu titles as an outline. The chapter 
structure consists of an explanation of each command, followed by 
access and operating instructions for that command. If the com­
mand accesses a dialog box, descriptions of each section of the 
dialog box and its operation are given.

** te.



Chapter 1: Introduction To Flying Fadere -includes instructions 
for creating a mix, explains automation memory, and shows you 
how to choose Mix/Pass numbers.

Chapter 2: Fader, and Mute Modes -discusses the functions of 
buttons and LEDs on the Global Master and individual channels, 
explains groups and links, and contains information on recording 
modes.

Chapter 3: Flying Faders Computer -explains the computer, how 
to operate the mouse/trackball and keyboard, Microsoft Windows, 
and accelerator key functions.

Chapter 4: System Menu -discusses commands in the System 
Menu and lists procedures for using each command. This chapter 
covers various “housekeeping features".

Chapter 5: Mix Menu -informs you of commands in the Mix Menu 
and lists instructions for using each command. Chapter 5 includes 
the use of mix and channel editing features as well as saving and 
loading Mixes to and from disk.

Chapter 6: Options Menu -discusses commands in the Options 
Menu and lists the procedures for using these commands (pro­
gramming Smart Keys, Safety Nets, Glide rates, timecode and 
screen options, and using Text Pages).

Chapter 7: Transport Menu -explains the different features asso­
ciated with the tape transport (setting transport times, selecting the 
transport, auto record on/off, resetting the transport controller, 
etc.).

Chapter 8: Lists Menu -shows you how to access and use the 
lists that are used throughout Flying Faders (Label List, Event 
Lists, etc.).

Chapter 9: Gangs Menu -is used for Coalescing and Suspending 
groups, and for deleting groups and links.

Chapter 10: Help Menu -contains the Help windows and Undo.

Chapter 11: Glossary -contains definitions of terms used in this 
manual.

0-2
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Overview of 
Flying Faders
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W H A T  H A S  H A P P E N E D ?

1. As soon as good timecode was being received, automation 
was turned on and any fader move or event that occurred 
was recorded by Flying Faders, creating a Pass. This initial 
Pass is called the Preset and is stored in RAM and assigned 
a number which is displayed in the Mix/Pass counter at the 
bottom of the main screen. This Mix/Pass system is ex­
plained in the next section of this chapter.

2. After tape was stopped and automation was turned on for 
the second time, the Pass that was created (the number in 
the Mix/Pass counter) was played back.

AUTOMATION MEMORY
As soon as automation has been activated and good timecode is 
being received, the first fader touch or mute event that occurs will 
create a new Pass, which in turn becomes the current Pass. The 
next time automation is activated, that Pass is played back and any 
new moves or events are recorded, creating another new Pass. 
Each Pass created becomes part of the Pass chain and is an up­
date of the one before it. In other words, as you play one Pass, 
you record an update of it. As you play that update back, you 
record a new update of it, and so on.

T H E R E  A R E  T H R E E  T IM E S  W H E N  A  N E W  P A S S  W IL L  
N O T  B E  C R E A T E D :

1. When RUN is turned off (disabling automation).

2. When no timecode is being received.

3. When no faders are touched and no new events occur.

Flying Faders stores information from each of these Passes in 
RAM. Any Pass may be stored to hard disk or floppy disk for more 
permanent safekeeping. (Refer to Chapter 5, "Mix Menu", for more 
information.)

mmmsszM:
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OVERVIEW OF 
FLYING FADERS

MAKING A SIMPLE MIX
N ote.............. If Flying Faders is not powered up, refer to Chapter

3, ‘Turning on Flying Faders”.

1. Click on theOptfons title in the menu bar at the top of the Flying 
Faders main screen.

2. Click on the77mecocfe Options title in the Options menu.

3. Go to the Timecode Format box on the left side of the dialog 
box and click on the circle next to the timecode that you are 
using.

4. Click on the OK button. (For more information, refer to Chapter 
6, ‘Timecode Options".)

5. Set the faders and mutes as you want them for the initial set­
ting.

6. Press RUN on the Global Master. (In most installations the 
Global Master is the control panel near the faders.) The RUN 
button will come on solid.

7. Put the transport into play. The SHIFT light on the Global 
Master will be on solid, indicating that good timecode is being 
received. When good timecode is being received, the RUN 
LED will flash, indicating that automation is on. Flying Faders is 
now ready to play and record moves and events.

8. Make the desired moves and events.

9. Stop the transport and rewind tape to the starting point (or any 
other desired point).

10. Play the tape again to play back what was recorded.

N ote..__ ....... Automation may be started or stopped at any point
in timecode and the Pass will play from that point.

OVERVIEW OF FLYING FADERS



SELECTING A MIX/PASS

SELECTING THE CURRENT MIX/PASS

The Mix/Pass that is currently playing may be changed from the 
Global Master or a dialog box on the screen. To go to another Mix 
or Pass from the Global Master, use the Plus or Minus buttons. To 
change the Mix/Pass numbers from a dialog box, refer to Chapter 
5, “Select Mix/Pass”.

TO SELECT A MIX/PASS FROM THE GLOBAL 
MASTER:

1. End the current Pass by stopping tape (timecode) or by 
turning RUN off.

2. Use the Plus and Minus buttons on the Global Master to in­
crement or decrement the Pass number. Use the 
SHIFT+Plus or Minus buttons to access another Mix branch. 
For example, if you are at Mix 2/Pass 2, in the previous ex­
ample:

and wish to go back to Mix 1/Pass 8, then the keys to press 
would be:

PASS - (selects Mix 2/Pass 1)
PASS - (selects Mix 1/Pass 8)

or
SHIFT+PASS - (selects Mix 1/Pass 10) 
PASS - (selects Mix 1/Pass 9)
PASS - (selects Mix 1/Pass 8)
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MIX PRESET
When a new Pass is created from Mix 1/Pass 0, Flying Faders 
takes a snapshot of the initial fader, mute, and channel button posi­
tions. This preset is used to establish the fader starting positions 
for all subsequent Passes in that chain and may be changed at any 
time. (Refer to "Trim Faders" in Chapter 5, for more information.)

CREATING A NEW MIX
Normally the Pass that was just created becomes the next Pass to 
be played. But, if you didn't like that Pass and don't want to use it..,, 
next, you can step back to any previous Pass.

When you move back to an earlier Pass, resume tape play, and 
record new moves, Flying Faders creates a new branch at that 
point and automatically assigns a new Mix number to it. Mix num­
bers are used as references to separate different branches of a 
Pass chain. For example, say that you have made a chain of 10 
Passes, each one an update of the one before it.

MIX l lM IX  11  MIX 11  MIX 11  MIX 11  MIX 11  MIX 11  MIX 11  MIX l lM IX  1
pASSj*|PipS|»pAp|̂ ^

The last Pass that was recorded was Mix 1/Pass 10. If you de­
cided to go back and play an earlier Pass from the chain (say Pass 
number 8) then Flying Faders would branch off at that Pass, giving 
the branch a new Mix number as well as a new Pass number (Mix 
2/Pass 1 in this case). If you play back and make any changes on 
Mix 2/Pass 1, the resultant Mix/Pass will be Mix 2/Pass 2, and so 
on.

1 -*OVERVIEW OF FLYING FADERS



SETTING THE SYSTEM TO MIX 1/PASS 0
If you wish to delete all Mix/Pass information currently in RAM, then 
refer to Chapter 5, “Clear Mix Memory”. If you wish to leave all the 
Mix/Pass information in RAM but want to start a completely new 
Mix with no presets, fader moves, or events, then use the Plus and 
Minus buttons to decrement to Mix 1/Pass 0, or refer to Chapter 5, 
"Select Mix/Pass”.

warn
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FADER, MUTE, & CHANNEL 
BUTTON MODES

FADER MODULE OVERVIEW
A . MUTE Button

This button is used to turn the mute on and off.

B. M ute RECORD LED
This LED is used as a  recording indicator, RSi 
(Ready, Safe, and Isolate) indicator, and as a Touch 
Record and Lock Record indicator for the mute.

C. M ute RECORD Button
This button is used to toggle between mute Touch 
Record and Lock Record modes. When RSI on the 
Global Master is enabled, this button (used in 
conjunction with SELECT) is also used to toggle 
through RSI for the mute.

D. SOLO Button and LED
This button is used to place a channel in and out of 
Solo. The LED indicates that a  channel is in Solo. 
(Solo must first be enabled at the Global Master.)

E. SELECT Button and LED
This button is used in conjunction with mute and 
fader RECORD for selection and interrogation of 
RSI, for the assignment and interrogation of Groups 
and Links, and as a  fader and mute touch indicator.

F . Fader RECORD LED
This LED is used as a  recording indicator, RSI 
indicator, and a  Touch Record and Lock Record in­
dicator for the fader.

G . Fader RECORD Button
This button is used to toggle between Touch Record 
and Lock Record modes for the fader. When RSI on 
the Global Master is enabled, this button (used in 
conjunction with SELECT) is also used to toggle 
through fader RSI.

H. MATCH LEDs
The Match LEDs show the direction needed to move 
the fader in order to return it to the Play Pass 
position. They are also used for Group and Link 
interrogation.

I. AUTO/MATCH LED
This LED is used as a Match and Auto Match mode 
indicator.

J . MATCH Button
When pressed, a  Match is performed. When used 
in conjunction with the fader RECORD button, the 
Auto Match mode will be activated.

FADER, MUTE, A CHANNEL BUTTON MODES 2-3
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GLOBAL MASTER MODULE OVERVIEW

A. MUTE Button
Inactive

B. Mute RECORD LED
This LED is used as a  global mute Touch Record and 
Lock Record indicator and a global RSI indicator.

C. Mute RECORD Button
This button is used to globally select mute Touch Record 
or Lock Record modes. When RSI is enabled, this 
button (used In conjunction with SELECT) is also used 
to globally toggle through mute RSI.

D. SOLO Button and LED
When used with the Global Master SHIFT, this button 
will enable and disable Solo. SOLO also selects be­
tween momentary and latching button operation, as well 
as serving as a  global Solo cancel.

E. SELECT Button and LED
This button is used in cor^ unction with the mute or fader 
RECORD buttons for global RSI assignment and interro­
gation and for selection and interrogation of Groups and 
Links.

F. Fader RECORD LED
This LED is used as a  global fader Touch Record and 
Lock Record indicator as well as a  global fader RSI 
indicator.

G. Fader RECORD Button
This button is used to globally toggle between fader 
Touch Record or Lock Record modes. When RSI is 
enabled, this button (used in conjunction with SELECT) 
is also used to globally toggle between fader RSI.

H. MATCH LEDs
Inactive

I. AUTO/MATCH LED
This LED is used as a  global Match and Auto Match 
indicator.

J. MATCH Button
When pressed, a  Match is performed on a  global level. 
When used in conjunction with the fader RECORD  
button, Auto Match will be activated for ail faders.

K. GROUP Button
GROUP enables and disables the Group assign mode.

L. UNK Button
LINK enables and disables the Link assign mode.

M. RSI Button
RSI enables and disables the RSI select mode.

N. OTHER Button
OTHER currently enables and tfsabies Trim or Graph.

O. RUN Button
RUN turns automation on and off.

P. Plus (+) and Minus (-) Buttons
The Plus (+) and Minus (-) buttons are used for incre­
menting and decrementing the Mix/Pass counter and for 
applying global Trim amounts.

Q. SHIFT Button
SHIFT is used in conjunction with the Plus (+) and Minus

SI buttons to change Mix numbers and for applying 
lobal Trim amounts. It is also used as a  modifier for 

the OTHER and SOLO buttons.
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SELECT
The functions of the Select buttons are controlled by the GROUP, LINK, RSI, 
and OTHER buttons on the Global Master. The use of the Select button for 
each of the assign/select modes on the individual faders will be discussed in 
their instructions.

GROUP
This feature allows you to select a master fader and to assign slaves to that 
fader. If moves or mutes are made with the master, its slaves move or mute 
with ft, but, moving or muting a slave does nothing to the master or to the 
other slaves. The master fader position does not provide an absolute level 
set to the slave faders, but rather a simple offset in level. This allows for a 
slave to completely override a group move (such as a fade) if desired. Mutes 
follow two simple rules:

1. If a group master is muted, all associated slaves will also be 
muted.

2. If a group master is unmuted, all associated slaves will reflect 
their individual status.

Important .... Channel buttons are not included in groups.

Group moves and mutes are recorded on the master fader only. This means 
that if a slave fader is removed from a group, ft will no longer follow the fader 
moves or mute events associated with that group. Because of this, all group 
structures in a mix are included in the information which is kept to disk and 
groups are re-formed when the mix is loaded from disk. (See "Coalesce 
Groups" in Chapter 9.)

GROUP HIERARCHY

With Flying Fader groups, a multi-level group structure or hierarchy 
may be formed. A simple example would be to create four groups 
consisting of rhythm, strings, brass, and vocals respectively, then 
create another group with it’s slaves consisting of the master fader 
of the other four groups. In essence, what is being set up is a 
master, sub-master, slave arrangement.

FADER, MUTE, A CHANNEL BUTTON MODES 2-5



A more complicated example would be a film mixdown, where the 
dialog mixer, music mixer, and effects mixer each set up their 
portion of the console with a master, sub-master, slave arrange­
ment. The dialog mixer may then create group masters on his 
console for the music and effects mixes, and then place a grand 
master over everything. This set-up would have five levels of 
grouping.

GROUP CHARACTERISTICS
1. Any number of groups may be formed.
2. A master may have any number of slaves.
3. Any fader may be a group master, even if that fader is a 

slave in another group.
4. A slave can have only one direct group master. A slave may 

have any number of indirect group masters as a result of 
group hierarchy.

5. Group moves and mutes are recorded on the group master 
fader only. Slave moves and mutes (other than those 
caused by the group) are recorded on the respective slave 
fader.

6. The underlying status of a slave's mute may be toggled 
while the slave is responding to a group mute.

7. A fader cannot be assigned to one group and its mute to an­
other.

8. RSI settings of a group master do not affect it's slaves, and 
vice-versa

9. When a mix is kept to disk, group structures are included in 
the mix information.

10. Groups are always functional, regardless of fader modes, 
automation status, or presence of timecode (unless they are 
Coalesced or Suspended). Refer to Chapter 9, "Gangs", for 
more information.

11. Channel buttons are not included in groups.

12. Solo does not respect group assignments. (Soloing a mas­
ter will not solo its slaves.)

TO CREATE A GROUP:

1. Press GROUP on the Global Master to enable the group 
assign mode (GROUP LED on).
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2. Press the SELECT button on the fader that is to be the 
group master (the SELECT LED will flash).

3. Press the SELECT button on each fader that you wish to 
add (SELECT LED on) or remove (SELECT LED off) 
from this group. (If a fader’s MATCH LEDs are on dim, 
that fader is already a slave in another group and may 
not be a member of this group.)

4. Press the SELECT button on the group master (SE­
LECT LED off).

5. Repeat for other groups or press GROUP on the Global 
Master to disable the group assign mode (GROUP LED 
off).

Note. If you wish to delete all groups currently in RAM, 
refer to Chapter 9, “Gangs".

GROUP INTERROGATION
The following section contains three methods of group interroga­
tion.

INTERROGATION BY USING SELECT:
1. Turn off all assign mode buttons (GROUP, LINK, RSI,

OTHER) on the Global Master.

2. Press the SELECT button on the fader of interest.

3. The MATCH LEDs on all faders will stop showing any
match offsets and display one of the following:

a. Upper MATCH LED on solid: The fader is an indirect 
master of the selected fader.

b. Upper MATCH LED flashing: The fader is a direct 
master of the selected fader.

c. Lower MATCH LED flashing: The fader is a direct 
slave of the selected fader.

d. Lower MATCH LED on solid: The fader is an indirect 
slave of the selected fader.

e. Both MATCH LEDs on dim: The fader is a slave in 
another group and is not eligible to be a slave to the 
selected fader.

f. Both MATCH LEDs off: The fader is not a member of 
a group.
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INTERROGATION BY TOUCH:
1. Turn off the assign mode buttons (GROUP, LINK, RSI, 

OTHER) on the Global Master.

2. Touch a group master fader (its SELECT LED will flash).

3. All direct and indirect slaves will turn on their SELECT 
LEDs.

INTERROGATION OF OVERALL GROUP 
STRUCTURES:

1. Press GROUP on the Global Master to enable the group 
assign mode (GROUP LED on).

2. Press the SELECT button on the Global Master.

3. The SELECT LEDs on all faders will display one of the 
following:

a SELECT LED off: Fader is not part of a group.

b SELECT LED flashing bright: Fader is a group mas­
ter only.

c. SELECT LED flashing dim: Fader is a group master 
to one group and a slave in another group.

d. SELECT LED on: Fader is a slave only.

Im portant.... For information on Group Coalesce, refer to Chap­
ter 9, "Coalesce Groups", in the Gangs menu.
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LINK
This feature allows you to interconnect faders so that moves or mute events 
that occur on any member of a link will be cloned to the other link members. 
Touching the fader or pressing the mute of a link member is exactly the same 
as touching all of the other members of the link at the same time.

Important .... Channel buttons are not included in links.

Link moves and mute events are recorded to each link member. This means 
that if a fader is removed from a link, it will still play back all previously written 
fader moves and mutes associated with that link. As a result, links may be 
created and broken up at any time without the loss of moves or mutes. All 
current links in a mix are included in the information which is kept to disk, and 
the links will be re-formed when loading the mix from disk.

Important .... When a link member is touched, the current fader 
balance between link members will freeze (touching 
one is the same as touching all). Underlying moves 
will be recorded over, with the possibility that the 
amount of Match offset will vary from member to 
member. Performing a Match on one member will 
force all members to Match.

LINK CHARACTERISTICS

1. Any number of links may be formed.

2. A link may have any number of members.

3 A fader may be a member of only one link.

4. Link moves and events are recorded to each link member.

5. A fader cannot be assigned to one link and its mute to an­
other.

6. Changing modes on a link member changes modes for all.

7. When a mix is kept to disk, links are included in the mix in­
formation.

8. Links are always functional, regardless of fader modes, 
automation status, or presence of timecode.

9. Channel buttons are not included in links.

10. Solo does not respect link assignments. (Soloing a member 
will not solo the other members.)
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Note A fader may be assigned to both a link and a group. 
Link moves have priority over group moves, but 
group mutes will take precedence over link mutes.

TO CREATE A LINK:

1. Press LINK on the Global Master to enable the link 
assign mode (UNK LED on).

2. Press the SELECT button on a fader that is to be a link 
member (the SELECT LED will flash).

3. Press the SELECT button on each fader that you wish to 
add (SELECT LED on) or remove (SELECT LED off) 
from this link.

4. Press the SELECT button on the fader whose SELECT 
LED is flashing (SELECT LED off).

5. Repeat for other links or press LINK on the Global Mas­
ter to disable the link assign mode (UNK LED off).

Note ............ If you wish to delete all links currently in RAM, refer
to Chapter 9, “Gangs”.

TO TEMPORARILY SEPARATE A FADER FROM A  
LINK:

1. Touch any fader in the link other than the one you want 
to separate.

2. Touch the fader that you want to separate while keeping 
your finger on the first fader.

3. Take your finger off the first fader (while keeping your 
finger on the other fader). The second fader will be re­
moved from the link temporarily, but will rejoin the link as 
soon as you release It.

ADJUSTING UNK FADER BALANCE

To adjust the relative balance of a fader in a link, separate it
from foe link and move it to foe desired position.
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TO TEMPORARILY SEPARATE A MUTE FROM A LINK:
1. Press any mute in the link other than the one you want to 

separate.

2. Press the mute that you want to separate while keeping 
your finger on the first mute.

3. Press the mute RECORD button of the first mute before 
releasing its mute button. This will prevent a toggle of 
the mute upon releasing the first mute button.

4. Toggle the separated mute as you like.

LINK INTERROGATION

Link interrogation may be performed by using the SELECT LED or 
by touching the faders.

INTERROGATION BY USING SELECT:
1. Turn off all assign mode buttons (GROUP, LINK, RSI, 

OTHER) on the Global Master.

2. Press the SELECT button on the fader of interest (SE­
LECT LED will flash). The SELECT LEDs of all link 
members will flash.

INTERROGATION BY TOUCH:
1. Turn off all assign mode buttons (GROUP, LINK, RSI, 

OTHER) on the Global Master.

2. Touch the fader of the fader of interest (SELECT LED 
will flash). The SELECT LEDs of all link members will 
flash.
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RSI (READY RECORD, SAFE, ISOLATE)

Faders and mutes can be set to Ready Record, Safe, or Isolate. If set to 
Ready, the playback and recording of moves and/or events is allowed. If set 
to Safe, the playback of previously made moves and/or events is allowed, but 
new moves or events can not be recorded. If set to Isolate, automation is 
disconnected, prohibiting the playback or recording of moves and/or events. 
RSI for faders and mutes may be set on individual faders or globally, by using 
the SELECT and RECORD buttons. The RECORD LEDs are used to indi­
cate the current RSI setting of a fader or mute.

RSI Setting 

READY 

SAFE 

ISOLATE

RECORD LED 

flashing 

on solid 

off

N ote.................These settings are shown only if RSI is on and the fader's SE­
LECT button is pressed.

LOCAL FADER RSI SELECTION:

1. Press the RSI button on the Global Master to enable RSI 
assign (LED on).

2. Press and hold the SELECT button on the desired fader.

3. Press the fader RECORD button to select the desired 
setting.

4. Press RSI on the Global Master to disable RSI assign.

LOCAL MUTE RSI SELECTION:

1. Press the RSI button on the Global Master to enable 
RSI.

2. Press and hold the SELECT button on the desired fader.

3. Press the mute RECORD button to select the desired 
setting.

4. Press RSI on the Global Master to disable RSI.
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GLOBAL FADER RSI SELECTION:
1. Press the RSI button on the Global Master to enable 

RSI.

2. Press and hold the SELECT button on the Global Mas 
ter.

3. Press the fader RECORD button on the Global Master to 
select the desired setting.

4. Press RSI on the Global Master to disable RSI.

GLOBAL MUTE RSI SELECTION:
1. Press the RSI button on the Global Master to enable 

RSI.

2. Press and hold the SELECT button on the Global Mas 
ter.

3. Press the mute RECORD button on the Global Master to 
select the desired setting.

4. Press RSI on the Global Master to disable RSI.

N o te _______ You may de-select any faders whose RSI
setting you don’t want changed by pressing 
their individual SELECT buttons (SELECT 
LED off) while pressing the SELECT button 
on the Global Master.

RSI INTERROGATION

If RSI is on, then the RSI setting of a fader or mute may be deter­
mined by pressing the SELECT button on the desired fader(s) and 
looking at the RECORD LEDs. RSI may be viewed globally or on 
individual faders.

TO VIEW RSI SETTINGS BY FADER:
1. Press RSI on the Global Master (LED on).

2. Press and hold the SELECT button on the desired fader 
to see the RSI status of that fader and mute.

TO VIEW RSI SETTINGS GLOBALLY:
1. Press RSI on the Global Master (LED on).

2. Press and hold the SELECT button on the Global Master 
to see the status of faders and mutes on all faders.
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OTHER
The OTHER button on the Global Master allows you to access the Trim 
Faders dialog box and the Graph window. Graph is discussed in this section, 
but since Trim may be accessed via a menu as well as by OTHER, it is cov­
ered in Chapter 5, "Trim Faders".

GRAPH
This feature allows you to see moves made by a fader in any se­
lected Mix/Pass. There are two ways fader moves may be dis­
played: The first shows one minute of moves (30 seconds on 
either side of the current timecode location). For example, if the 
timecode was stopped at 01:25:00, then moves from 01:24:30 to 
01:25:30 would be drawn. The second mode displays ALL moves 
for the entire Mix/Pass.

Graphs are displayed in 6 colors to help distinguish them. Time- 
codes are the same color as their graph and displayed in 8 digit 
format without colons. Additionally, timecodes are displayed 
without Local Zero offset applied and therefore the timecode dis­
played for a graph will be exactly the same whether or not Local 
Zero is on. Remember that windows of this type may be moved 
and/or resized.

TO GRAPH FADER MOVES:

1. Make sure that the OTHER button on the Global Master 
is off.

2. Press the Global Master SHIFT+OTHER button, or click 
directly on Other Key box on the main screen, so that 
the box displays Graph (not Trim).

3. Press the OTHER button on the Global Master and the 
Graph window will be opened.

4. Press the SELECT button on the fader(s) that you wish 
to graph. (This displays one minute of moves.) To dis­
play all moves over the entire Mix, hold SHIFT on the 
Global Master and press SELECT on the desired 
fader(s).

5. Press the Global Master SHIFT+OTHER to clear the 
Graph window.

6. Press the OTHER button to close the Graph window.
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FADER, MUTE, AND CHANNEL 
BUTTON RECORD MODES

This section explains the Record modes for faders, mutes, and channel 
events.

important .... Recording of fader moves, and mute and channel events only 
occurs when:

1. Good timecode is being received (SHIFT LED on solid).

2. Run is selected (RUN LED is flashing).

3. Appropriate RECORD LED is flashing.

FADER RECORD MODES

When the RSI setting for a fader is set to Ready, various record 
modes become available. These modes may be selected at any 
time, at each individual fader or globally at the Global Master Mod­
ule.

TOUCH RECORD
in this mode the fader starts by playing back the moves of 
the Play Pass. When you touch the feder, all moves that 
you make will be recorded. Upon release, the fader will 
resume playing back the moves of the Play Pass, along with 
any offset in level incurred. The Match LEDs will indicate if 
an offset is present.

Note__.......... If timecode is interrupted (stop tape, etc.) or RUN is
turned off with an offset in effect, the offset will be 
carried out to the end of the mix. A Match must be 
performed if this is not desired. (Refer to “Match" in 
this section.)

TO SET A FADER TO TOUCH RECORD:
1. The selected fader’s RSI must be set to Ready.

2. Press the feder RECORD button so that the fader Rec­
ord LED and AUTO MATCH LED are both off.
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TO GLOBALLY SET FADERS TO TOUCH RECORD:
1. The selected faders’ RSI must be set to Ready.

2. Press the Global fader RECORD button so that the 
Global fader RECORD LED and AUTO MATCH LED are 
both off.

Note .— .— . A fader’s RECORD LED will flash slowly when re­
cording in Touch Record. When in Ray, the LED 
will be off.

LOCK RECORD
In this mode, the fader starts by playing back the moves of 
the Play Pass. When you touch the fader, all moves that 
you make will be recorded. Upon release, the fader will 
continue in record as if being touched, staying in the position 
where you released it. (If the fader is in a group or a link, it 
will still follow all group or link moves while recording in Lock 
Record.) Recording ends at that point in the mix when one 
of the following occurs:

1. A Match is performed.
2. The fader is taken out of Ready.
3. Run is turned off.
4. Timecode is stopped (stop tape,etc.).

The MATCH LEDs will indicate if an offset is present.

Note ............ If timecode is interrupted (stop tape, etc.) or RUN is
turned off with an offset in effect, the offset will be 
carried out to the end of the mix. A Match must be 
performed if this is not desired. (Refer to “Match” in 
this section.)

TO SET A FADER TO LOCK RECORD:
1. The selected fader’s RSI must be set to Ready.

2. Press the fader RECORD button so that the fader REC­
ORD LED is on and the AUTO MATCH LED is off.

TO GLOBALLY SET FADERS TO LOCK RECORD:
1. The selected faders’ RSI must be set to Ready.

2. Press the Global fader RECORD button so that the 
Global fader RECORD LED is on and the AUTO MATCH 
LED is off.
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Note.................A fader's RECORD LED will flash quickly when
recording in Lock Record and will be on solid in 
Play.

A U T O  M A TC H

In this mode, the fader starts by playing back the moves of 
the Play Pass. When you touch the fader, all moves that 
you make will be recorded. Upon release, the fader will 
automatically perform a Match, gliding back to the Auto 
Match position. When the Glide ends, play is resumed. The 
Auto Match Glide rate may be changed from the Glide 
Times dialog box. (Refer to Chapter 6, “Glide Times”.)

N otes............ If timecode is interrupted (stop tape, etc.) or RUN is
turned off with an offset in effect, the offset will be 
carried out to the end of the mix. A Match must be 
performed if this is not desired. (Refer to “Match” in 
this section.)

As the fader glides during an Auto Match, it will in­
creasingly follow the dynamics of the Ray Pass 
moves.

T O  S E T  A  FA D E R  T O  A U T O  M A TC H :

1. The selected fader’s RSI must be set to Ready.

2. Simultaneously press the fader RECORD and MATCH 
buttons. (The AUTO/MATCH LED will come on solid.)

T O  G L O B A L LY  S E T  FA D E R S  T O  A U T O  M A TC H :

1. The selected faders' RSI must be set to Ready.

2. Simultaneously press the fader RECORD and MATCH 
buttons on the Global M aster. (The AUTO/MATCH LED 
will come on solid.)

Notes.............The fader RECORD LED will flash when recording
in Auto Match. (Recording occurs while the fader is 
being touched and during the Glide.) The AUTO/ 
MATCH LED will flash while the fader is Gliding. 
When playing, the RECORD LED will be off and the 
AUTO/MATCH LED will be on solid.
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In the Auto Match mode, the MATCH LEDs point 
toward the Auto Match position while recording a 
move. When the fader is playing moves, the 
MATCH LEDs point toward the Play Pass position 
(if there is an offset). Pressing the MATCH button 
will perform a Match (not Auto Match) eliminating 
the offset from the Play Pass position.

M A TC H

Whenever you want the fader to Glide from its current posi­
tion to the Play Pass position, press the MATCH button and 
the fader will move to the Play Pass position. Once there, 
recording ends and playback of old moves begins. The 
Match Glide rate may be changed from the Glide Times 
dialog box. (Refer to Chapter 6, “Glide Times”.)

Notes .......... As the fader glides during a Match, it will increas­
ingly follow the dynamics of the Ray Pass moves.

Match does not affect faders in Isolate.

T O  P E R F O R M  A  L O C A L  M A TC H :

Press the MATCH button on the fader at the point in the 
mix that you wish the fader to Glide to the Play Pass po­
sition.

T O  P E R F O R M  A  G L O B A L  M A TC H :

Press the MATCH button on the Global Master at the 
point in the mix that you wish all faders to Glide to their 
respective Ray Pass positions.

Note ............ The fader RECORD LED will flash when recording
in the Match mode. The AUTO/MATCH LED will 
flash while the fader is Gliding.
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MUTE RECORD MODES
When RSI for a mute is set to Ready, two record modes become
available. These modes may be selected at any time at each indi­
vidual mute, or globally at the Global Master Module.

T O U C H  R E C O R D

In this mode, the mute starts by playing back the mutes of 
the Play Pass. Upon pressing down on the mute button, 
record is activated. During the time that you hold the button 
down, all underlying Play Pass mutes will be ignored. Upon 
releasing the mute button, the mute will toggle and recording 
ends. The mute will resume playback of the Play Pass at 
the next event which will cause the mute to toggle to the 
opposite state.

Im p o rtan t If two sequential "on" mutes exist on the same
channel, the latter mute will remain in the Mute List 
as long as tape (timecode) does not play past that 
mute. For example, a mute "on" has been recorded 
at 01:05:45:03. On a subsequent pass, a mute "on" 
is recorded two minutes prior at 01:03:44:27 and 
then tape (timecode) is stopped before the mute at 
01:05:45:03. If you look at the Mute List, both 
mutes are included in the list and do, in fact, exist. 
On the other hand, if tape (timecode) is played past 
the mute at 01:05:45:03 and no other mutes exist 
between these two points, the mute at 01:05:45:03 
will be deemed redundant and removed, automati­
cally creating a new Mix/Pass.

T O  S E T A  M U TE  TO  T O U C H  R E C O R D :

1. The selected mute’s RSI must be set to Ready.

2. Press the mute RECORD button so that the mute REC­
ORD LED is off.

T O  G L O B A L L Y  S E T  M U TE S  T O  TO U C H  R E C O R D :

1. The selected mutes’ RSI must be set to Ready.

2. Press the mute RECORD button on the Global Master so 
that the mute RECORD LED is off.

N ote.............. A mute’s RECORD LED will flash slowly when re­
cording in Touch Record and will be off while play­
ing.
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TO ERASE MUTE EVENTS:

1. The selected mute’s RSI must be set to Ready.

2. Select the Touch Record mode.

3. Press down on the mute button (to activate record) just 
ahead of the mute event to be erased.

4. Continue to hold the mute button down until you have 
passed the unwanted mute event(s).

5. Press the mute RECORD button before releasing the 
mute button. This will cause the mute not to toggle upon 
release of the mute button.

L O C K  R E C O R D

In this mode the mute starts by playing the mutes of the Ray 
Pass. Upon pressing down on the mute button, record is 
activated and locked on. Upon releasing the mute button, 
the mute toggles and recording continues. As long as rec­
ord is activated, all underlying Play Pass mute events will be 
ignored. Recording ends when one of the following occurs:

1. The mute is taken out of Ready.

2. Run is turned off.

3. Timecode is stopped (Stop tape, etc.).

Im portant.... If two sequential "on" mutes exist on the same
channel, the latter mute will remain in the Mute List 
as long as tape (timecode) does not play past that 
mute. For example, a mute "on" has been recorded 
at 01:05:45:03. On a subsequent pass, a mute "on" 
is recorded two minutes prior at 01:03:44:27 and 
then tape (timecode) is stopped before the mute at 
01:05:45:03. If you look at the Mute List, both 
mutes are included in the list and do, in fact, exist. 
On the other hand, if tape (timecode) is played past 
the mute at 01:05:45:03 and no other mutes exist 
between these two points, the mute at 01:05:45:03 
will be deemed redundant and removed, automati­
cally creating a new Mix/Pass.
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T O  S E T  A  M U TE  IN  LO C K  R E C O R D :

1. The selected mute’s RSI must be set to Ready.

2. Press the mute RECORD button so that the mute REC­
ORD LED is on solid.

T O  G L O B A L L Y  S E T  M U TE S  IN L O C K  R E C O R D :

1. The selected mutes' RSI must be set to Ready.

2. Press the mute RECORD button on the Global Master so 
that the mute RECORD LED is on solid.

Note........ ......A mute’s RECORD LED will flash quickly when
recording in Lock Record and will be on solid while 
playing.

C H A N N E L  B U TTO N  R E C O R D  M O D E S

This section explains Touch Record and Isolate for channel but­
tons.

T O U C H  R E C O R D

If set to Touch Record, the channel buttons start by playing 
back the events of the Ray Pass. Upon pressing down on a 
channel button, record is activated for that button. During 
the time that you hold the button down (activating record) all 
underlying Play Pass events for that button will be ignored. 
Upon release, it will toggle and recording ends. The channel 
button will resume playback of the Ray Pass.

ISOLATE
Channel buttons are unaffected by fader and mute RSI 
settings, but they may be placed in Isolate by disabling the 
desired channel button in the Automate Channel Buttons 
dialog box. (Refer to Chapter 6, "Automate Channel But­
tons", in the Options menu.)
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SOLO
Flying Faders provides an in place, muting solo that is independant of the 
console’s solo. The Flying Fader's Solo is unique because the fader remains 
unmuted, allowing you to insert mutes without losing the signal. The main 
features of the Flying Faders solo system are:

1. Solo events are not recorded.

2. Channels in solo do not play back previously recorded mutes.

3. New mute events can be recorded on channels that are in solo.

4. Solo may be disabled.

5. Momentary or latching button operation.

Im portant..... System Master Modules (stereo bus masters, etc.)
are configured so that they are not included in the 
Solo system (Solo safe). Other channels may also 
be made Solo safe by reconfiguring them as Sys­
tem Masters. (Refer to "Using the MKINIT System 
Initialization Utility” in the Flying Faders Technical 
Manual.)

T O  E N A B L E /D IS A B L E  S O L O :

1. Press the Global Master SHIFT+SOLO.

T O  S O L O  A  C H A N N E L :

1. Enable Solo.

2. Press SOLO on the channel that you wish to solo.

M O M E N T A R Y  O R  LA T C H IN G  O P E R A T IO N

The solo buttons may be set to momentary or latching operation.
The SOLO button on the Global Master is used to toggle between
these two options. It is also used as a solo cancel when in the
latching mode, allowing you to turn off all solos that are active.

M O M E N T A R Y  O P E R A T IO N :

Press SOLO on the Global Master so that its LED is off. A 
fader will be in solo only while its SOLO button is held down.
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LA TC H IN G  O P E R A TIO N :

Press SOLO on the Global Master so that its LED is on. A 
fader will latch in solo when its SOLO button is pressed. 
Pressing the fader's SOLO button again will cancel solo for 
that fader.

Note.................When the latching mode is selected, the SOLO
button LED on the Global Master will flash while any 
fader is in solo.

A D D IT IO N A L  N O TE S  O N  S O L O

Solo does not recognize Groups and Links. If a Group or Link 
master fader is placed in solo, the associated slave faders will not 
be affected.

Faders that are in solo will be unmuted and will remain so until they 
are taken out of solo. Faders that are not in solo will mute and re­
main muted until they are placed in solo or until all faders are taken 
out of solo. Once again, remember that mutes and unmutes 
caused by solo are not recorded by Flying Faders.
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FLYING FADERS 
COMPUTER

TURNING ON FLYING 
FADERS

1. Turn on the AC MAINS breaker and the MOTOR POWER switch 
on the Flying Faders power supply unit.

2. Turn on the computer and the video display unit (VDU).

Note.................. Remove any disks that might be present in the
floppy drive before applying power to the com­
puter.

If you have a mix data disk or another floppy disk in the drive, this
error message will appear:

Non-System disk or disk error.
Replace and strike any key when ready.

Remove the disk and hit any key on the computer keyboard to con­
tinue the automatic load from the hard disk. When the system is
ready for mixing, the blue Flying Faders screen will appear.

Important ___...If at any time the Flying Faders screen remains
red longer than one minute, turn the computer off 
and back on again. If this doesn't solve the prob­
lem, call Neve service.
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MICROSOFT WINDOWS
The Flying Fader’s human interface is made possible through the 
use of Microsoft Windows. Windows is an integral part of Flying 
Faders, providing a graphic display of the operating parameters of 
the system. Upon powering up Flying Faders, both Windows and 
the Flying Faders program are automatically loaded. If you are not 
familiar with Microsoft Windows, we recommend that you read this 
section before you start using Flying Faders.

P A R T S  O F  A  W IN D O W
'Menu

Control Box /  Menu Title

TLYING FHDLRS

Menu Bar

I
a s tw IM ic  f lp tlo is  T ransport L is ts  f ia ijs  Ir ip ?

C lie n t J L n fo rn a tio n ...
C a lib ra te  Faders
Run R eca ll Softw are *T
Fornat a Floppy
Now N ix D is k ...

M ARTINSOUND STUDIOS

r i T I H l  r A I E I I
by  M ARTINSOUND Technologies

Reset S fs teu

Show Rate and T in e ...
Show Nenory S ta t is t ic s . . .  
Show C jinsole S ta t is t ic s . . .  
Show D iagnostics W indow ...

emm

• ♦ eJmma

I Locate Tines

P lay f r e e : ----- — J— -----------

Stay a t : ----- ----------- 1----- -------1-----

S afe ty Nats L*trn  CaPtH r*  N aU kadi -Cycle Lecate < S 3 ii
C lid e  T ines ii......... iNik Pass | Off | Stop 

00:00:00:00
i m Trim

S ate : j

N ates: j

P la y : ]  £  

R e c : _____ __________

Figure X I: Rying Fader's mein screen wkh the'System* menu box pulled down

A  W IN D O W  M A Y  IN C L U D E :
1. Menu B ar-C ontains the names of the menus in the system. This is the 

horizontal fist across the top of the Flying Faders screen. (Figure 3.1)

2 . Menu - Contains a  list of ail the commands and dialog boxes contained in that 
particular menu. (Figure 3.1)

3. C ontrol Box - Used to close, clear, or quit the active window. (Figure 3.1)

4. Scroll Bar - Used for viewing information that w ont fit in the entire window.
(Figure 3 2 )

5. D ialog Box - Displayed when more information is needed to carry out a 
command. (Figure 3 2 )
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Automate L'IihuiihI H u t t o n s

-Automate These—  
Buttons:

On These Channels' 
1 S elect 1X1 )

BEQ
H  Insert 
SI Hon Cut 
SI Chan Cut 
□  Cut Ml Bus

1 C li <101101 t i t2 Channel 023 Channel 33
4 Channel 34
5 Channel 35
6 Channel 33
7 Channel 37 
3 Channel 38 
9 Channel 39

Scroll Bar

G
( M«lp }

[ Cancel ) 

1 )

Figure £2; Automata Ctmnal Buttons dialog box.

USING THE MOUSE/TRACKBALL
Your system comes with either a mouse or a trackball. This point­
ing device controls the pointer on the screen. If you position the 
pointer over the function to be executed and dick the mouse/ 
trackball button, that function will be performed.

Note....................If you have a pointing device with more than one
button, use the leftmost button to control Flying 
Faders.

C O M M O N  P O IN T IN G  D E V IC E  T E R M S :

Click - Press the button once.

Double Click - Quickly dick the button twice.

Ftgunxs: The ■mouse• Drag - Click the button and hold it down while moving the mouse/ 
trackball. When finished, release the button.

T H E  P O IN TE R  U S E D  FO R  FLY IN G  F A D E R S  H A S  
FO U R  S H A P E S :

I
Arrow - Used for the selection of functions.

I-Beam - A pointer that is used for entering text. For example, if 
you move the pointer around in the Load Mix dialog box, you will 
notice that when the mouse/trackball is in the areas where text is to 
be inserted, it changes from an arrow to an I-beam. The flashing 
vertical line in the box is the insertion point. This is where new text 
can be entered. The insertion point can be moved around with the 
pointing device or the space bar on your keyboard.
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Two-Headed Arrow - Used for changing the size of the Text 
Pages window, Diagnostics window, Help window, and the Graph 
window. If you move the pointer over the border of a window, it 
changes to a two-headed arrow. Drag the two-headed arrow to 
change the window size.

Hourglass - The pointer changes to an hourglass figure while you 
are waiting for a function to be executed.

USING THE KEYBOARD
On your keyboard the keycap names may be abbreviated or repre­
sented a little differently. For example, the ENTER key on the 
standard keyboard (Figure 3.4) is the same as the EXECUTE key 
on the Neve V Series keyboard (Figure 3.5). in this manual, the 
name of a key in a keystroke appears in capital letters, for ex­
ample, ALT, SHIFT, TAB, etc. A plus sign (+) between two key­
strokes means to hold the first key and press the second 
(ALT-f CTRL). By using certain keystrokes, commands may be 
chosen to carry out functions on Flying Faders.

Here is a list of some frequently used keystrokes that are common 
to both keyboards:

ALT- Pressing ALT by itself will select the main screen 
menu title box.

ALT-f Underlined letter - To open a menu or go to an area 
within a dialog box. FOr example, look at the System menu 
title in the main screen menu bar. Notice that the aS" in 
System is underlined, if you press ALT+S, the System 
dialog box will open.

ARROW DIRECTION KEYS - Used to move through menu 
titles, menus, or between related options in a dialog box.

ESC or BACK - Used to backspace in text areas. (The 
same as pressing BACKSPACE on the standard keyboard.)

Figure 3l4: Standard keyboard

CANCEL • Voids or nulls the current operation. (The same 
as pressing ESC on the standard keyboard.)
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EXECUTE or RETURN - Executes any highlighted 
command in the menu bar, a menu, or a dialog box. (The 
same as pressing ENTER on the standard keyboard.)

TAB - Move between options in a dialog box.

SHIFT+TAB - Move backwards among options in a dialog 
box.

SPACEBAR - Select or de-select an option in a dialog box.
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BACK LOCATE « i » □ RECORD

©
FlgurmXS: Neve V Series keyboard
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SELECTING
Throughout this manual you will be instructed to select commands 
or items from the screen. You may do so with the mouse/trackball, 
the keyboard, dedicated keys, or a combination of all. These meth­
ods of selecting are described in this section. Elsewhere, the 
manual will simply refer to “select” and leave the best method up to 
the user. Take time to experiment with these different methods to 
find a combination that best suits you.

SELECTING MENUS 
AND MENU ITEMS

Clear Nix Henory
Irin Faiers...Uerye Charnel lata... F9
fiopy Charnel lata...Erase Channel Data...
Select Mx/Pass... Ft
Ron In

Figure 3.6: Using the mouse to 
select menu items.

When a menu name is chosen, that name is highlighted. When a 
menu is opened, the menu drops down from the menu bar to 
display its list of commands and dialog boxes. The following tech­
niques allow you to access a menu bar and its menus.

Note..................A  dialog box has ellipses (...) following its title to
distinguish it from a command.

U S IN G  T H E  M O U S E /T R A C K B A L L :

1. Click the desired menu title. (Figure 3.6)

2. Click on the command or dialog box title that you wish to 
select.

U S IN G  T H E  K E Y B O A R D :

1. Press ALT and then use the left or right arrow DIRECTION 
keys to select a menu title from the menu bar.

2. Press EXECUTE to open the menu.

3. Use the up and down arrow DIRECTION keys to select the 
command or dialog box from the menu list.

4. To execute the command or open the dialog box, press 
EXECUTE.

O r

1. Press ALT+underlined letter in the menu bar to select the 
desired menu.

2. Press the underlined letter in the menu list to choose the de­
sired command or dialog box.
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THE PARTS OF A DIALOG BOX
Most dialog boxes are made up of several different areas. This is an 
overview of the parts that make up dialog boxes and their use.

Load Mix

[ Client.. TOOIAS/CHASE
List of Projects:

[ Eroject... ]

[ ]

[ Hix---
( Show notes:

; T _
Command

Buttons

Option
Buttons

IdiText Box
i t■rion-i

Never Ending

used 2iList Box 7 %

Scroll Bar

guitar

~ftisk;
I Hard Disk O Floppy Disk 
Disk Nane: Mystery Disk

Free space: 
32290K Q

?] (Clear BAH) 
(Mini/Pass o)

I 1
Cancel ]

( Load 1
'Load Options----
□  Offset Tinecode

Set Offset
□  Swap Channels

Set Swai
annc

t

□  Coalesce Groups 
[ Set Groups

/
Figure 3.7: The Ixmd Mbf dUog bat. Check

Boxes

Inactive
Command

Button

A DIALOG BOX MAY INCLUDE:
1. List Box - This box contains choices available to the user. To 

make multiple selections from a list box that allows multiple 
selections, press and hold SHIFT then click and/or drag on your 
choices. To make more than one selection with a keyboard, 
use the SHIFT + ARROW direction keys. (Figure 3.7)

2. Text Box - This is where information is inserted by the user.
The flashing vertical line is the insertion point. Anything that 
you type will appear to the left of the insertion point, moving any 
existing text to the right. (Figure 3.7)

3. Scroll Bars - Used in list boxes and text boxes as well as in 
windows to view information that wont fit in the entire dialog 
box. You may use the mouse/trackball to operate the scroll bar 
by dragging the small white box that is in the scroll bar and re­
leasing it at the desired location. To scroll one line at a time, 
click the arrow boxes at the ends of the scroll bar. You may 
scroll one entire box length by clicking the scroll bar in the
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shaded area or by pressing PAGE UP or PAGE DOWN on the 
keyboard. (Figure 3.7)

4. Command Buttons - Used to perform various operations, such 
as approving or canceling settings in a dialog box. These are 
the buttons with curved sides. The button with the bold border 
is set as the default, meaning that if you press EXECUTE, that 
button will automatically be chosen, regardless of where you 
are in the dialog box. The three most common command 
buttons are:

OK - Selecting OK executes your choice and returns you to the main 
screen. (Figure 3.7)

CANCEL - Selecting CANCEL will return you to the main screen as if the 
dialog txix was never opened, voiding any changes. (Figure 3.7)

EXIT - Selecting EXIT will return you to the main screen.

HELP • Selecting HELP opens a  Help box dedicated to that particular 
dialog box. (Figure 3.7)

INACTIVE COMMANDS - If a command is shaded gray, it is in­
active and cannot be used at that moment. (Figure 3.7)

5. Option Buttons • Circular buttons used to select an option in a 
dialog box. (Figure 3.7)

6. Check Boxes - Small squares used to select one or more op­
tions in a dialog box. (Figure 3.7)

in order to select an item, you need to move to the location con­
taining that item. The following explains how this is done.

USING THE MOUSE/TRACKBALL:
1. Click directly on the area or setting that you want to select. 

(Figure 3.8)

SELECTING AN ITEM 
IN A DIALOG BOX

rDisk:
Hard Disk O Floppy Disk 
sk Name: Development Disk

Free space: 
195A2K

Flgurm X8: Point the mousoArackbaJt and dick.
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01:45:30:15
101:45:30:151
Figure 3 J ; Entering the en­
tire Timecode

01:45:30:15

0» 30:15
01:30:30:15

Figure 3.10: Editing the 
houre, mlnutee, eeconde, or 
fmmee eeperuteiy.

USING THE KEYBOARD:
1. Press TAB to move to the desired area. (You may also 

press SHIFT+TAB to move in the opposite direction.) The 
area that you are currently in will be highlighted.

2. Use arrow DIRECTION keys to go to a specific item within 
that area.

3. Press SPACEBAR to choose the item.

Or

1. ALT+underlined letter

2. Use arrow DIRECTION keys to go to a specific item within 
that area.

3. Press SPACEBAR to choose the item.

ENTERING TIMECODE NUMBERS:
1. Select the timecode field. (Figure 3.9)

2. Valid time code numbers may now be inserted. (Figure 3.9)

3. Select OK or go to the next option.

Hours, minutes, seconds, and frames maybe edited individually.

1. Select the timecode field.

2. Double click the mouse on the hours, minutes, seconds, or 
frames and a highlighted block will appear. (Figure 3.10)

3. Insert your changes. (Figure 3.10)

4. Select OK or go to the next option.

Or

1. Select the timecode field.

2. Press INSERT and a highlighted block will appear. Use the 
left or right arrow DIRECTION keys to move the block.

3. Insert your changes.

4. Select next option or OK.
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DIRECT-WINDOW ACCESS 
AND ACCELERATOR KEYS

There are alternate methods to open dialog boxes or execute com­
mands without going through the menus. They are as follows:

D IR E C T  W IN D O W  A C C E S S

Most primary functions can be accessed directly from the main 
screen via the mouseArackball For example, clicking on the Labels 
area on the main screen is the same as selecting the Label List 
from the Lists menu.

A C C E L E R A T O R  K E Y S

These are special keys used to execute a command without using 
the menu or the mouseArackball. For example, click on the Mix 
menu title. Notice the function key assignments to the right of the 
menu listings. If you wanted to open the Keep Mix dialog box with­
out using the pointing device, you would press the F7 key. Not all 
functions have accelerator keys, but the most commonly used do.

A C C E L E R A T O R  K E Y  A S S IG N M E N T S

-Accelerator keys on the Neve V  Series keyboard are labeled with 
their specific function.

•The majority of the accelerator keys on the standard keyboard are 
function keys F I-F I2. There are a few, however, that use CTRL 
(refer to the following list).

Neve Standard
Keyboard Keyboard Function Performed

LABEL............... (FI)........... .....Calls up the Label List
MUTE................. .... (F2)........... .....Calls up the Mute List
CH BUTTON .... .... (F3) ........... .....Opens the Channel Button

dialog box
EVENT............... .. (F4)........... .....Inactive
STORE ............ .... (F 5 ).............. .....Inactive
M IX/PASS........ .... (F6)........... .....Opens the Mix/Pass dialog

box
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KEEP (F 7 )................... Opens the Keep Mix dialog
box

LOAD ..................... (F 8 ).....................Opens the Load Mix dialog
box

M ERGE................... (F 9 ).....................Opens the Merge Channel
Data dialog box

C O D E ..................... (F I 0 ) ...................Opens the Timecode Options
dialog box

U N D O ......................(F11 ).................. Undoes the last command
C T R L + Z ................. C T R L +Z ...........Undoes the last command
HELP........................(F I 2 ) .................. Calls up General Info Help

menu
M A R K ......................C TR L+K ...........Adds a mark to the Label List
R EC A LL................C T R L +T ............Starts Recall on Neve V

Series
C TR L+R ................C TR L+R ............Run On/Off
C TR L+Q ................ C TR L+Q ............Quit Flying Faders
C TR L+A ................C TR L+A ............Repeats Last Command
C TR L+N ................ C TR L+N ............Safety Nets O n/O ff

SMART KEYS
Smart keys on the Neve V  Series keyboard (S I-S I 2) are for exe­
cuting user programmable command sequences. (Refer to Chap­
ter 6, "Options Menu", for programming information and Smart key 
access on the standard keyboard.)

DISK DRIVES
Your computer contains both a hard disk drive and a floppy disk 
drive. The Flying Faders program is installed on a portion of the 
hard disk, with the remaining space available for mix storage. The 
floppy disk (Figure 3.11) is generally used for archiving and trans­
ferring mix information. (Refer to Chapters 4 and 5, "System 
Menu" and "Mix Menu", for instructions on the use of the disk 
drives.)

Note ................ The floppy disk used for Flying Faders is a high
density disk (1.4 Megabytes). Be aware of the 
fact that 400K and 800K floppies won't work.
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SOFTWARE VERSION NUMBER

s
About Flying Faders...
ijev Features oF Version 1.2... 

fait *Q

As Neve and Martinsound Technologies continue to address the 
needs and wants of mixing engineers worldwide, we will be adding 
features and making changes to the Flying Faders software. If at 
any time you contact Neve with questions or comments regarding 
your Flying Faders system, you will need to inform them of the soft­
ware version installed in your system. The version number is 
found under the About Flying Faders menu in the main screen 
control box. (Figure 3.12)

About Flying Faders
Flying Faders 

Hunan/Autonation InterfaceK i by Joev Ron, Ed and Tin
j | --------------------------------------  A r

PC Software v. 1.2 
HP software u. 1.2

6 Copyright 1988, 1989 
Martinsound

Portions 8 Copyright 
Microsoft Corp., 1985-1988 

All rights reserved.
I a  )

Figure 3.12: Flying Fader's Vermon Number
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SYSTEM MENU

FLVING FADERS
Systen |flix flptions Transport
Client Jnfornation__
Calibrate Faders
Run Recall Software *T
Fornat a Floppy
Nane Nix Disk...

Lists fiangs jjelpt______________________
MARTINSOUND STUDIOS'LTIHfl FiBEIS

by MARTINSOUND Technologies

Reset Systen

Show fiate and Tine...
Show jjemory Statistics__
Show Console Statistics... 
S ho i^ iagnosticsjttnd^^

Locate Tines 
Play fron: —

LocateIRecord

Stop at:

Safety Nets 1Capture Rollback Cycle Locate >  >  II
Free RRH Other Key Glide Tines H x  Pass" Off Stop

101ft T rim
Ruto: j 
Natch: j

Play: J £  
Rec: ___  i_ i 00:00:00:00

The "System" pull-down menu k  found oh the menu bar located at the top of the mein Flying Faders screen.
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CLIENT INFORMATION
| S jS tM  1
Client I n f o r n a t i o n . ..
Calibrate Fabers 
Run Recall SeFtwre *T 
Farut a Flapfiy 
Haae Hix bisk...

Reset Systea

Sto« late art line...
Ska* jjeaari Statistics... 
Shaa Cflosale Statistics... 
Sna Riagaastics aiadoa...

This command allows you to inform Flying Faders of the current 
Client, Project, and Title being worked on. This information will 
appear in the Projed/Titie box of the main screen, as well as in the 
Keep, Load, and Delete dialog boxes. Client information may be 
changed from any of these dialog boxes and the changes will be 
automatically updated in the other locations.

T O  IN S E R T  C L IE N T  IN F O R M A T IO N :

1. Select Client Infornation from the System menu or click the 
Project/Title box on the main screen.

2. Insert the Studio, Client, Project, and Title names in the ap­
propriate boxes. (Note: Inserting a different studio name 
will not change the system default. It simply customizes the 
main screen for the current session.)

3. Select OK to close the dialog box.

Client Infornation Box

Studio Name: HAPPV FEET STUDIOS

Client: Tobias/Chase

project: Never Ending

Title: Confessions

U e lp f

Cancel

1 @  1

USERS MANUAL - CHAPTER FOUR



CALIBRATE FADERS
I System 1_ _ _ _ _ _ _ _ _ _ _
I Clift Information... |
Calibrate faders
Run Recall Softnare *T 
Format a Fltppy 
Han* Mix Risk...
Reset Systea
Slw« |ate and Tine...
Shea D e w y  Statistics... 
Shoe Console Statistics... 
Shaw Riagnostics Himdoo...

This command allows you to calibrate all of the faders, so that each 
fader ‘meets spec’. This insures that Flying Faders will accurately 
play back each of the moves that have been recorded. The entire 
calibration is automatic, takes approximately 20 seconds, and 
stores the results on the hard disk. The next time that you turn on 
or reset the system, the faders will be calibrated using these val­
ues, making it unnecessary to repeat this routine each time the 
system is used.

T O  C A L IB R A T E :

1. Select Calibrate Faders from the System menu.

2. A dialog box will appear on the screen indicating that calibra­
tion is taking place. Upon completion of calibration, any 
fader that does not ‘meet spec’ will have its channel number 
displayed in the dialog box indicating that servicing of that 
fader may be necessary. If a fader is suspected to be mar­
ginal, try calibrate once more before calling maintenance. 
(For servicing, refer to the Flying Faders Technical Manual.)

3. When calibration is finished, all faders and mutes will return 
to their previous positions. Select OK to close the dialog 
box.

Im p o rtan t............ If calibration seems necessary, it is best to do
so after the Flying Faders power supply unit 
has been turned on for at least fifteen minutes 
and preferably one hour.

RUN RECALL SOFTWARE
System_ _ _ _ _ _ _ _ _
Climt Information... 
Calibrate Faders
Run Recall Software
Format a Floppy 
Name Nix Risk...
Reset System
Shorn late and Time...
Shorn ftemory Statistics... 
Shorn Console Statistics... 
Shoo Diagnostics Hindoo...

This command will allow you to access certain features on Neve 
VR Series consoles. For further information, refer to the Recall 
Manual.
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FORMAT A FLOPPY
System
Clint inftraction...
Calibrate Faders
Run Recall Software *T
Fornat a Floppy
Haw Mix Risk...
Reset Systen
Shw |ate aad Tiw...
Shw yemry Statistics... 
Shw Ctnsale Statistics... 
Shw liagwstics Ittadw...

This command allows you to prepare a floppy disk for use with the 
Flying Faders system. A formatted disk is used to keep mixes for 
archival purposes or for carrying out mixes to another Flying Fad­
ers facility.

T O  F O R M A T  A  F L O P P Y :

1. Select Format a Floppy from the System menu.

2. The screen prompts will instruct you to insert a disk into 
drive A (the floppy disk drive), and then to select EXECUTE.

3. When formatting is complete, the screen will ask you “For­
mat Another (Y/N)”. If you would like to format another 
floppy disk, type “Y ’, press EXECUTE, and go through the 
sequence again. If you would like to exit back to the Flying 
Faders screen, type 'N \ then press EXECUTE. Your disk is 
now ready to keep mixes.

NAME MIX DISK
This command allows you to give a unique name to each disk. The 
disk name will appear in the Disk box of the Keep, Load, and De­
lete dialog boxes. This provides a way to verify that mixes are 
being kept to, loaded from, or deleted from the correct disk. It can 
also be used to differentiate original disks from back-up copies, etc.

T O  N A M E  A  M IX  D IS K :

1. Select Name Mix Disk from the System menu.

2. Select the disk to be named (Hard Disk or Floppy Disk).

3. Type the name to be used into the Mix Disk Name box.

4. Select OK to dose the dialog box.

Systen |_ _ _ _ _ _ _ _ _ _
Clint Infornatioo... 
Calibrate Faders.
Run Recall Software 
Fornat a Flippy_____
Ndnt1 llix Disk...

Reset Systn
Shw late aad Tiw...
Shw Jewry Statistics... 
Shw Console statistics... 
Shw liagwstics ftndw...

Nane Mix Disk
Mix Disk Maw:

Disk:©Hard Disk 
O floppy Disk

Mystery Disk

Help? ]  c Cancel OK
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RESET SYSTEM
This command allows you to do a total system reset, as if powered 
down and powered back up. This is an excellent way to prepare 
the system for a new session without rebooting.

Warning —  Because of the nature of this command, caution 
should be taken. All Mix/Pass information in RAM 
will be erased, so be sure to save important Mix/ 
Passes to hard disk or floppy disk before performing 
this command. * 1 2 3

T O  R E S E T  S Y S T E M :

1. Select Reset System from the System menu.

2. A dialog box will appear asking you to confirm the reset. 
Select OK to proceed or select CANCEL to return to the 
Flying Faders main screen.

3. After resetting the system, a dialog box will appear, inform­
ing you of the status of the transport controller. Select OK to 
close each dialog box.

Systen |_ _ _ _ _ _ _ _ _ _
Client Infamation... 
Calibrate Faders 
Ran RecaU SaFtaare *T 
Faraat a Flippy 
Kane Mx  Risk...
Reset Systen

Shea fate and Ik...
Shae jjaary Statistics... 
Shea Cgnsale statistics... 
Shea Piagnestics Rindoa...

SHOW DATE AND TIME
This command allows you to view the current date and time from 
the Flying Faders main screen.

T O  S H O W  D A TE  A N D  T IM E :

1. Select Show Date and Time from the System menu.

2. Select OK to close the dialog box.

(Refer to the Flying Faders Technical Manual to change the date 
and time.)

FLVING FftDERS - Notice

ia :3 *:*« A N  A p r il 23 . 1989

I B  I

Systen_ _ _ _ _ _ _ _ _ _ _
Client lafaraatioa... 
Calibrate Faders 
Run Recall SoFtaare *T 
Fomat a Fleppy 
Haw M x  Risk...
Reset Systen
Shou Date and limp...
Shoa denary Statistics... 
Shoa Cgnsale Statistics... 
Slwa Piagnestics Medea...
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SHOW MEMORY STATISTICS
Systra |_ _ _ _ _ _ _ _ _ _
Clicat laFaraatiaa... 
Calibrate Faders 
Run Recall Saftuire "I 
Farnat a Flappy 
Naae Nix bisk...
Reset Systea
Shaw late and Tine...
Shou IJpnnry Statist i c s. ..
I Shea Cflnsale Statistics...! 
Isbaw Playaostics Window...|

This command allows you to view the status of the system RAM. 
When selected, a dialog box appears informing the user of the 
memory available, memory used, and the total amount of RAM in 
your system.

T O  S H O W  M E M O R Y  S T A T IS T IC S :

1. Select Show Memory Statistics from the System menu, or 
click on the Free RAM area in the lower left comer of the 
main screen.

2. Select OK to dose the dialog box.

HYING ffiDFRS - Notice

enory a v a ila b le  842*886 
R6H nenory used 9892 
R6M used+auailab le  3833978 
Percentage unused 99.7351

___________________5]

i b  i

SHOW CONSOLE STATISTICS

3ystan|_ _ _ _ _ _ _ _ _ _
Client laFaraatiaa... 
Calibrate Faders 
Run Recall Saftnre *T 
Fernat a Flappy 
Nane Nix Risk...
Reset Systea
Skew (ate and Tine...
Skew jjeanry Statistics...
Shou Console statistics...

|Sk»u Piayaastics Window...|

This command allows you to view the status of faders and mutes. 
When selected, a dialog box appears, informing you of the current 
modes of faders and mutes.

T O  S H O W  C O N S O L E  S T A T IS T IC S :

1. Select Show Console Statistics from the System menu.

2. Select OK to dose the dialog box.
H YINC FfiDfcRS - Nut ice

Faders In  s a fe : 1-6 8 - 9 6 E 
Faders in  is o la te : 7 f
Mutes in  add: 1-5 7-96 I
Mutes in  s a fe : 6 I

o

I B  )
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SHOW DIAGNOSTICS 
WINDOW
jjstn
Client Inferiutien... 
Calibrate Faders 
Ran Recall Seftware *l 
Foraat a Floppy 
Haiie Hix bisk...
Reset Systen
Shea (ate and line...
Shoe geaary Statistics... 
Shoe Cgnsole Statistics...
Shou Diagnostics Uindou...

This command allows you to enter the "command line" of Flying 
Faders. Most users should never need to access this window, but, 
if you wish to view this window you are strongly urged to refer to 
the "Diagnostics Window" chapter in the Flying Faders Technical 
Manual.

T O  S H O W  D IA G N O S T IC S  W IN D O W :

1. Select Show Diagnostics Window from the System menu.

2. Refer to the Flying Faders Technical Manual.

3. Select the control box, then select Close Diagnostics Win­
dow to return to the Flying Faders screen.

lostics Window]
Close Diagnostics Window
Clear Window

Binary Translation

♦
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MIX MENU
5  . FLVING FADERS
£yste* Mix | Aptions Iransport Lists fiangs flelpt

/
Keep Hix...
Load Hix... 
fielete Hix...
Show Hix Statistics...
Show HLx/Pass Iree__
Clear Hix Henory

F7
F8 MARTINSOUND STUDIOS.Tlifl FADES!

by MARTINSOUND Technologies
Pro lei
Tit: Trin £aders...

Label! Merge Channel Data__ F9
P £opy Channel Data... 

Erase Channel Data...
b Select Hix/Pass... F6

Locate Run On ILocate|Record
Play fro*:

Safety Nets 1Eapture Rollback Cycle Locate > > II
Free RAH Other Key Glide Tines Hix Pass Off | Stop

loot T rim
Auto: j 
Hatch: j

Play: j £  
Rec: ___  ___ 00:00:00:00

The “Mix' pul-down menu k  found on the menu bar located at the top of the main Flying Faders screen.
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KEEP MIX

m
Keep Mix... F7
Load Mix... FI
fielete Mix...
Show Mix S tatistics... 
Shoo Hix/Pass Irce ... 
Clear Nix Nraory

Trio Eiders...
Merge Channel Data.. J9  
£opy Channel Data... 
Erase Channel Data...

Select Hix/Pass... F« 
Dun On *1

This command allows you to store a mix, along with mix-related 
information, from the system’s RAM to the hard disk and/or your 
floppy disk for permanent safekeeping. Remember that your mixes 
are held in RAM as you work. In the event of a power failure, 
mixes in RAM will be lost. Keeping to disk now and again is good 
insurance, especially in areas with power difficulties. Keeping is 
also done for archival purposes or for carrying out mixes to another 
Flying Faders facility. The Keep Mix command will not affect the 
Mix/Pass information in RAM. The data which will be kept in­
cludes:

1. All fader moves

2. All mute events

3. Groups and Links

4. Mix Notes

5. Locate Times (including Preroll)

6. Reel Start & End Times

7. Auto Record Times

8. Label List (title specific)

9. Channel Names List (title specific)

10. Glide Times

11. Smart Keys

12. TlmecodeType

13. Local Zero

If your Flying Faders system is equipped with Events, the following 
data will also be included:

1. All channel button events

2. All A/B Cut Bus events

M IX /P A S S

The mix that will be kept to disk is the Mix/Pass that is displayed in 
the Mix/Pass counter on the main screen.
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Keep -  Mix *4 Pass 2

MM I I II

List of Mixes: 
Muffin 
Pancake 
Pancake.SI

J jix ___

N ix  jjo te s :

Pancake
Great Mixf The Hungry Guys did it again?

rLocate Tines
Select fron List Play Fron: 00:10:Ok:05 Stop At: 00:15:10:20

yisk: <§> Hard Disk O Floppy Disk 
Disk Name: Mystery Disk

Help?
.* ' \ Cancel

I K,e»> )

Important .... The Keep Mix command will only recognize the mix 
resulting from the Pass chain, not the Pass chain 
itself. Mix/Pass numbers are simply locate points in 
RAM for different mixesl

F IL E  O R G A N IZ A T IO N

Flying Faders keeps mixes in a traditionally organized filing system. 
Sets of files will be presented in alphabetical order. The principle 
files are your Clients (e.g. record companies). Under a specific 
client name are subfiles, which are the different Projects (e.g. 
artists’ albums) that the client is working on. Under each project 
are sub-subfiles, which are the different Titles (e.g. songs) for that 
project Under these titles will be found the related mixes that you 
have kept

‘W O R K N A M E ’ D E FA U LTS

If you open the Keep Mix dialog box without giving Flying Faders 
any Client Information, the Client box will read ‘workclient’. This is 
the system default along with ‘workproject’, ‘worktitle’, and 
‘workmix’. These defaults have been inserted so that you may 
keep with minimal keystrokes and/or minimal interfacing with the 
screen. Keeping to these ‘work’ files is not necessarily in yo u r best
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interest, as it can be difficult to distinguish one ‘workmix’ from 
another. But you will find it useful for that “one-off" session, that 
quick scratch mix, or to help a novice get started on Flying Faders. 
And remember, if a ‘workmix’ develops into a master or final mix, 
then you may keep under an actual Client, Project, Title, and Mix 
name at that time.

M IX  V E R S IO N  N U M B E R S

To avoid redundant mix files, the system automatically assigns a 
mix version number to all subsequent keeps of a previously used 
mix name (e.g. FINAL, FINAL01, FINAL02).

T IT L E  V E R S U S  M IX

When you keep, most of the information is directly related to a 
specific mix name. But the information pertaining to the Label List 
and Smart Keys is shared by all mixes under a specific title name. 
As a result, if you keep a mix after making changes to the Label 
List or Smart Keys, the changes will be found in all previously kept 
and future kept mixes with the same title name.

M IX  N O T E S

The Mix Notes box is used for adding comments to the mix that 
you are about to keep. Comments may include: Describing subtle 
differences between similar mixes or version numbers, document­
ing Merge parameters, noting timecode offsets for machine control­
lers, etc. Mix Notes from the Mix/Pass dialog box are automatically 
copied to this box.

L O C A T E  T IM E S

The times displayed in the Locate Times area of the main screen 
will be included with the mix that you are about to keep. These 
times will be shown in the Locate Times box of the Keep Mix dialog 
box. The Select From List command button allows you to change 
the Locate Times.

D IS K

The Disk box allows you to choose the storage medium (hard disk 
or floppy disk) to which a mix will be kept.
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T O  K E E P  A  M IX :

1. Insert the Mix/Pass that you wish to keep in the Mix/Pass 
counter on the main screen. (Refer to "Select Mix/Pass" in 
this chapter.)

2. Press KEEP on the Neve V Series keyboard, or select Keep 
Mix from the Mix menu.

3. Insert the appropriate names in the Client, Project, Title, and 
Mix boxes.

4. Insert any mix notes into the Mix Notes box.

5. Insert any changes into the Locate Times box.

6. Select the disk to which you will keep. Check the Disk 
Name to verify that you are keeping to the correct disk. Also 
check the “Free Disk Space” indicator to insure that there is 
room for your mix.

7. Select Keep to store the mix to disk.

8. A dialog box will appear indicating that your mix has been 
successfully kept. Select OK to close the dialog box.

♦
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LOAD MIX

Keep Hix... F7
Load Mix... F8
delete Hix...
Show Hix Statistics... 
Shim Hix/Pass Iree ... 
Clear Hix Heinrp

Trix £aders... 
flerge Channel Data.. J9  
£opp Channel la ta ... 
Erase Channel Data...

Select Hix/Pass... Fi 
Run On *1

This command allows you to choose a mix from a disk and dupli­
cate it in the computer’s RAM. Loading a mix will not disturb any 
other mixes in RAM, the system simply finds the first available Mix/ 
Pass location and places the mix there. This provides a way of 
loading multiple mixes in RAM for mix editing. Mix-related informa­
tion is recalled when loading a mix and is used to reset several as­
pects of the system. The following will be reset:

1. Groups and Links

2. Mix Notes

3. Locate Times (including Preroll)

4. Reel Start and End Times

5. Auto Record Times

6. Label List

7. Channel Names List

8. Glide Times

9. Smart Keys

10. TimecodeType

11. Local Zero

M IX  1 /P A S S  0  V S . C L E A R  R A M

In order to load a mix, the Mix/Pass counter must be set to Mix 1/ 
Pass 0. There are two ways to do this: If the mixes currently in 
RAM are not to be erased, then click Mix 1/Pass 0. Or, if there is 
nothing in RAM that is needed, click Clear RAM. This will also 
return you to Mix 1/Pass 0.

Warning ...... Because of the nature of the Clear RAM command,
caution should be taken. All Mix/Pass information in 
RAM will be erased, so be sure to save important 
Mix/Passes to hard disk or floppy disk before per­
forming this command.

S H O W  N O T E S

This command allows you to preview your mix notes for the se­
lected mix, so that you may confirm your choice before loading.
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Load Mix

£lient... ] TOBIAS/CHASE
List of Mixes: 
IFinal
F inal . U1

E r o j e c t .

Iitle...

itlx..

Newer Ending

Craw Dad

Final .01

Mutes

Show notes: Ida Red llersion

rfiis k : ----------------------------------
©  Hard Disk O Floppy Disk
Disk Mane: Mystery Disk

Free space: 
32298K

"Load Options'
DjOfFset Tiwecode

Set Offset
□  Swap Channels

Set Swaps

IS

0

Clear b a h ) 
(Mixl/PassB) 
I Help! ) 
[ Cancel ; 
[ Load )

□  Coalesce Groups
Set Groups

D IS K

The Disk box allows you to choose the disk (hard disk or floppy 
disk) from which a mix will be loaded.

LO A D  O P T IO N S : O F F S E T  T IM E C O D E

This function allows you to resolve any possible differences be­
tween the timecode originally used when the mix was kept and the 
timecode currently being used. This can be useful in video produc­
tion, where timecode gets shifted quite often.

LO A D  O P T IO N S : S W A P  C H A N N E L S

This function allows you to trade data between channels when 
loading a mix to RAM. It is useful to resolve differences in console 
configurations or console sizes when loading mixes that were 
saved at other Flying Fader installations.

L O A D  O P T IO N S : C O A L E S C E  G R O U P S

This function allows you to Coalesce a Group or Groups upon load­
ing a mix to RAM. Refer to Chapter 9, "Gangs", for more informa­
tion.
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T O  LO A D  A  M IX :

1. Press LOAD on the Neve V Series keyboard, or select Load 
Mix from the Mix menu.

2. Select the Clear RAM or Mix 1/Pass 0 command button.

3. Select the disk that contains the mix that you want to load 
from the list of mixes.

4. Select the Client command button. The list of clients will 
now appear in the list box.

5. Select the desired client from the list.

6. Repeat steps 4 and 5 to obtain the desired project, title, and 
mix names. Hint: If you double click on your choice from 
the list, it will be placed in the text box and the next list will 
show up, eliminating the need to use the Project, Title, and 
Mix command buttons.

7. Go to the Load Options box If you need to offset the time- 
code, swap channels, or Coalesce Groups upon loading.

8. Select Show Notes if you wish to confirm your choice.

9. Select the Load command button to load your mix and to 
close the dialog box.

DELETE MIX

Vs
Keep Nix... F7
Load Nix... FI
Delete Mix.. .
soon Hi* S tatistics... 
Slut* Kix/Pass Iree ... 
Clear Nix Hem?

IriR Eaders...
JJerge Channel la ta .. J9  
£opil Channel la ta ... 
Erase Channel la ta ...

Select Hix/Fass... Fi 
Mm On *«

This command allows you to remove a mix from a disk. Delete is 
used for reclaiming valuable disk space, e.g. removing old mixes 
from the hard disk, eliminating all the backup mixes before a final 
mix, etc. You may also remove Clients, Projects, and Titles from a 
disk.

Im portant.... Because of the system file arrangement, (refer to 
File Organization under Keep Mix), if you delete a 
client, then all associated projects, titles, and mixes 
will be deleted. If you delete a project, then all as­
sociated titles and mixes will be deleted. Likewise, 
If you delete a title, then all of its associated mixes 
will be deleted.
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Delete Mix
List of Mixes:

[ Client... ] TOBIAS/CHASE Final (w/acoustic bass) D
Final (w/o acoustic bass) II 
Mutes ■  
Rough Mix 1f Eroject... Never Ending

[ Jitle... Confessions

( Mix... Final (w/acoustic bass)

[ Show IJotes: 600D MIX, USED SECOND TAKE OF PIANO ±

Help! J
fiisk: ©  Hard Disk O  Floppy Disk Free sP « e :3255AK gfil

Disk Name: DISK 1 OF 2
Exit 

[ {Delete]

S H O W  N O TE S

This command allows you to preview your mix notes for the se­
lected mix, so that you may confirm your choice before deleting.

D IS K

The Disk box allows you to choose the storage medium (hard disk 
or floppy disk) from which a mix will be deleted.

T O  D E LE TE  A  M IX :

1. Select Delete Mix from the Mix menu.

2. Select the disk that contains the mix that you wish to delete.

3. Select the Client command button. The list of clients will 
appear in the list box.

4. Select the desired client from the list.

5. Repeat steps 3 and 4 to obtain the desired project, title, and 
mix names. Hint: If you double click on your choice from 
the list, it will be placed in the text box and the next list will 
show up, eliminating the need to use the Project, Title, and 
Mix command buttons.

6. Select Show Notes if you need to confirm your choice.
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7. Select the Delete command button.

8. A dialog box will appear asking you to confirm your choice. 
Selecting YES will permanently delete your choice. (Not 
even EXIT will be able to correct deleted items after this 
point, so be extremely careful when using Delete.)

SHOW MIX STATISTICS

W ]_____________
Keep Nix... F7
Load Nix... FI
fielete Nix...
Show Hix Statistics...
Shoo Hix/Pass Iree ... 
Clear Hix Hemry

Trio Eaders... 
flerge Channel la ta . .T9 
Copy Channel la ta ... 
Erase Channel la ta ...

Select Hix/Pass... FI 
Run On *1

This command allows you to view certain details about the current 
Mix/Pass chain. It informs you of the points in timecode between 
which all fader moves have occured. It indicates the faders on 
which there are fader moves, mute events, and channel button 
events. It also notifies you of the amount of memory used by the 
Mix/Pass chain that you are currently in.

T O  S H O W  M IX  S T A T IS T IC S :

1. Select Show Mix Statistics from the Mix menu. A dialog box 
displaying facts about the current Mix/Pass will appear.

2. Select OK to dose the dialog box.

fl V I Ht; I AIM K S  - N u t  i i;p
S ta t is t ic s  abou t H ix :1  P ass:1 
Moves fro n  000003 to  000016 
Fader m ves Mi- 7 M 
Mute eve n ts  "1 -0 "
Ch. e ven ts  "none”
Menorjp s iz e  o f c u rre n t * ix :1 5 3 8 i

$

n

[ B  J
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SHOW MIX/PASS TREE

5 3 _____________
Keep Mix... F7
Load Mix... FI
fielete Mix...
Shoe Mia Statistics...
Shou llix/Pass Jree...
Clear Nix Henry

Trin £aders...
Merge Channel Data.. J9 
£opy Channel Data... 
Erase Channel Data...

Select Kix/Pass... F6 
Run On ‘R

The Mix/Pass Tree maps out ail related Mix/Pass numbers and 
allows you to see their relationship with one another. Whenever a 
new mix is created, Flying Faders starts a new branch so you can 
easily view the heirarchy of the Mix/Pass numbers.

T O  S H O W  M IX /P A S S  T R E E :

1. Select Show Mix/Pass Tree from the Mix menu.

2. A help window will appear showing the current Mix/Pass 
tree.

Help Window

-1/0
'—1/ 1—1/ 2—1/ 3—1/ 4—1/ 5—1/ 6—1/ 7—1/ 8—1/9

I
• —2/1—2/2—2/3—2/4—2/5—2/6—2/7—2/8—2/9

I
* —3/1—3/2—3/3—3/4—3/5—3/6—3/7—3/8

CLEAR MIX MEMORY
This command allows you to clear all current Mix/Pass information 
from RAM, resetting the Mix/Pass counter to Mix 1/Pass 0.

Warning ...... Because of the nature of this command, extreme
caution should be taken. All Mix/Pass information in 
RAM will be erased, so be sure to save important 
Mix/Passes to hard disk or floppy disk before per­
forming this command.

T O  C LE A R  M IX  M EM O R Y:

1. Select Clear Mix Memory from the Mix menu.

2. A dialog box will appear to verify your request to delete all 
Mix/Pass information currently in RAM.

3. Select OK or CANCEL

m \_____________
Keep Mix... F7
Load Mix... FD
fielete Mix...
Shou Mil S tatistics... 
Shou Mix/Pass Iree ...
Clear Mix llenory

TriR Eaders...
Merge Channel Data.. J9 
Kopy Channel Data... 
Erase Channel Data...

Select Mix/Pass... Fi 
Run On *|

HYING FflDfRS

Ire you sore you twit to lelete all idx/pass ^ 9  iofonution fron mmry? Ill nix/pass 
x f inftnutint will le lost.

G«D
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TRIM FADERS

w«|_____________
|eep Nix... F7
Load Nix... FI
{elete Nix...
Shoo Nix S tatistics... 
Shoo Nix/Pass l m . . .  
Clear Mix Heitory
Trin Faders...
Herge Channel Data...F9 
£opy Channel Data... 
Erase Channel Data...
Select Nix/Pass... F6 
lun In *R

This command allows you to adjust the level of all or some of the 
faders for the current Mix/Pass. You may trim through a dialog 
box, the Global Master, or by moving the faders manually. Trim 
may be adjusted when automation is on, so you can see and hear 
the effects in real time. The Trim may be set to occur between two 
times, or the entire Mix/Pass may be Trimmed.

N o te ............. The Mix/Pass that you are adjusting is left undis­
turbed in RAM. If automation is on and the trim 
amount has been set, Flying Faders creates a new 
Mix/Pass as soon as OK is selected or tape (time- 
code) is stopped. If automation is still on and you 
decide that you don't want to create a new Mix/ 
Pass, Trim can be cancelled by turning off the 
OTHER button on the Global Master or selecting 
CANCEL in the dialog box. At that point the faders 
will return to their original positions.

NUDGE TRIM

The Nudge Trim box has buttons that will let you trim in fixed steps 
of +1 dB, -1 dB, +0.1 dB, and -0.1 dB each time these are selected.

NUMERIC TRIM

The Numeric Trim box is similar to Nudge Trim, except that instead 
of fixed values, any number can be entered by typing it from the 
keyboard. Once a number is entered, the Trim+ and the Trim- 
buttons will apply that amount each time you select them.

I r i m  Fdders

Channels ( Select ail 1
1 Channel «1 It]
2 Channel «2 □
3 Channel 33 ■
k Channel »  ______ ■5 Charmel 115
6 Channel *6 ■
7 Channel m ** ■

-tJuneric Trin---------
[ Trin ♦ j

L j r t * -  I

Hudge Trin
[ ♦  1 . 0  dB) ( ♦  S.1 dB)

O  I"

in dB
l . l

O  preset ®  end

Trl’ * * " •  00:12:04:00 ‘"o  00:0559:29
xFade tine in:|l j xFade tine out:ll j

Take new Preset

_ 1 flelpt 1

CancelI

. I " ' " — ]

j Set Trin Tines'")

□  Suspend groups
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itjlpv rropi; irxn i d :

LM M  0 0 : 1 2 : 0 4 : 0 0 Lattel 0 0 : 0 5 : 5 9 : 2 9

1 00:80:53:01 MM
2 00:00:58:15 H
3 00:01:08:25 I I
4 00:01:17:29 ■
5 00:01:43:25 ^

1 08:00:53:01 -9
2 00:00:58:15
3 00:01:08:25 ■
4 00:01:17:29 ■
5 00:01:43:25 ■

Trie in xFade tine: | l  | Trin out xFade tine: | l  |

Help! Cancel [ flK ]

T R IM  B E TW E E N  T IM E S

The area at the bottom of the screen allows you to select the points 
between which the Trim will occur. The Trim may be designated to 
affect the entire Mix/Pass or only a selected section. If the Trim is 
assigned to take place between two timecode points, crossfade 
times may be set for the crossfade in and crossfade out. The time- 
code points and the crossfade times may be set by selecting the 
Set Trim Times command button.

S U S P E N D  G R O U P S

The Suspend Groups box in the lower right comer of the Trim 
dialog box allows you to Trim a Group master without affecting its 
slaves. Refer to Chapter 9, "Gangs", for more information on 
Suspend Groups.

T A K E  N E W  P R E S E T

This command replaces the existing preset with the current fader 
positions, creating a new Mix/Pass.

T O  T A K E  A  N E W  P R E S E T:

1. Turn automation on (play tape, Run on).

2. Make the desired moves or mutes.
3. Stop tape.
4. Select Trim Faders from the Mix menu.
5. Select the Take New Preset command button.
6. A notice box will appear informing you of the new Mix/Pass 

that was created.

Note________ A new preset may be taken only once for each time
the Trim Faders dialog box is opened.
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T O  T R IM  U S IN G  T H E  T R IM  FA D E R S  D IA L O G  B O X :

1. Call up the desired Mix/Pass.

2. Select Trim Faders from the Mix menu. The Trim box on 
the main screen will turn green and the OTHER button will 
flash on the Global Master.

3. Select the faders that you wish to trim from the Channels list 
box.

4. Select or enter the points that you wish to Trim between 
(preset to end or between times).

5. Play tape. As you select buttons from the Numeric Trim or 
Nudge Trim boxes, the specified amount will be applied to 
the current Mix/Pass, creating a new Mix/Pass when OK is 
selected or tape (timecode) is stopped.

T O  T R IM  FA D E R S  FR O M  T H E  G L O B A L  M A S T E R :

1. Call up the desired Mix/Pass.

2. Make sure that the OTHER button on the Global Master is 
off.

3. Press the Global Master SHIFT+ OTHER, or dick on the 
Other Key box on the main screen, so that Trim (not Graph) 
is displayed in the Other Key box.

4. Press the OTHER button on the Global Master. The OTHER 
button will light, the Other Key box will turn green, and the 
Trim Faders dialog box will open.

5. Select the faders that you wish to adjust from the Channels 
list box.

6. Select or enter the points that you wish to Trim between 
(preset to end or between times).

When Trim is enabled, the + and - buttons on the Global Master
become preset amounts of trim.

PLUS (+) equals +.1dB
MINUS (-) equals -.Id B
SHIFT+PLUS (+) equals +1dB
SHIFT+MINUS (-) equals -Id B

Note ............ Where SHIFT is listed above, we are referring to the
SHIFT key on the Global Master.
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T O  T R IM  FA D E R S  M A N U A LLY :

1. Call up the desired Mix/Pass.

2. Make sure that Trim" is displayed in the Other Key box on 
the main screen, then press the OTHER button on the 
Global Master to open the Trim Faders dialog box.

3. Activate automation and manually move the fader(s) that 
you want to trim. When you release the fader(s) it will play 
its moves with the new preset applied. If further adjustment 
is needed, move the fader(s) again.

4. When you are satisfied with your adjustments, stop tape 
(timecode) or select OK and a new Mix/Pass will be created.

MERGE CHANNEL DATA
W l_____________
Keep Nix... F7
Load Nix... F8
lelete Nix...
Show M.& Statistics... 
Shov Hix/Fass Iree ... 
Clear Nix Neaory

Trit faders...
Merge Channel Data...F9
Copy Channel Data... 
Erase Channel la ta ...

Select Mx/Pass... F6 
ion la “R

This command allows you to take channel information (fader 
moves, and/or mute events, and/or channel button events) from a 
selected Mix/Pass and insert it into another Mix/Pass. You may 
specify the exact length of the information to be merged. The 
Merge command will not alter the Mix/Pass that you merge from or 
to, but will create a new Mix/Pass, which will be displayed in the 
Mix/Pass area. Merge is very fast, as it is done entirely in RAM, 
not on disk.

Merge Channel Data
"TaJje Fron Here-  

Mix Pass

□  n
[Current Pass)

"Insert In Here- 
Mix Pass
F H  □
[Current Pass)

"Include

g)Faders
B  Mutes 
□  Ch Buttons

"Splice Hode 

@ Absolute
xFade t in e : |l | 

O  Relative
rSet Tines--------------------------------------------------------------------------------------------------------- 1

Select fron L ist Nerge fron O Q lQ Q lS B ’ l S  lterse * • 0 0 : 0 1 : 4 3 2 5

Channels [ Select N il 1
| i Channel «1 13

2 Channel U2 ■
3 Channel S3 ■
4 Channel S* |
5 Channel ss I6 Channel S6 ■7 Channel •7 __1

Help! Cancel ( Merge} )
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T A K E  FR O M  H E R E  A N D  IN S E R T  IN  H E R E

The Mix/Pass that you want to copy information from, also known as 
the source mix, is entered in the Take From Here box. The Mix/Pass 
that you want to introduce the information into, also known as the des­
tination mix, is entered in the Insert In Here box.

IN C L U D E
i

The Include box allows you to select which elements are to be merged 
from a channel’s mix information. You may select fader (the fader 
movements) and/or mute (the mute events) and/or channel buttons 
(the channel button events).

S P L IC E  M O D E

The Splice Mode box allows you to select whether the transitions be­
tween the source mix and the destination mix, at the merge start and 
end times, are to be Absolute or Relative. (The choice will affect the 
faders only. In both modes, the status of the mute and channel but­
tons on the selected channels) will be forced to match the source mix 
at the merge start time. At the merge end time, the status of the mute 
and channel buttons on the selected channel(s) will be forced to match 
the destination mix.)

A B S O L U T E

If Absolute is chosen, the selected fader(s) will crossfade from 
the destination mix position to the source mix position at the 
merge start time. This is done over the frames you allocate in 
the xFade Time box. At the merge end time, the selected 
fader(s) will move back to the destination mix position, once 
again occurring over the time shown in the xFade Time box.

R E L A T IV E

If Relative is chosen, the selected fader(s) will follow the source 
fader mix moves, referenced to the destination mix position at 
the merge start time. In other words, the selected fader(s) will 
follow the source mix moves with a relative offset At the merge 
end time, the selected fader(s) will resume following the desti­
nation mix moves.
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S E T  T IM E S

The Set Times box allows you to select the start and end points in 
timecode for the mix information to be merged. These points are 
referred to as Merge From and Merge End. Timecode may be 
entered manually or from the Label list by choosing Select From 
List.

C H A N N E L S

The Channels box allows you to select the channels) whose mix
information will be merged.

N ote.............. The data for channels that were not selected will not
be altered in the destination Pass.

T O  M E R G E  C H A N N E L  DATA:

1. Press MERGE on the Neve V  Series keyboard, or select 
Merge Channel Data from the Mix menu.

2. Enter the desired Mix/Pass in the Take From Here box or 
select the Current Pass command button to insert the 
current Mix/Pass.

3. Enter the desired Mix/Pass in the Insert In Here box or 
select Current Pass to insert the current Mix/Pass.

4. Select the channel mix information to be merged from the 
Include box.

5. Select Absolute or Relative from the Splice Mode box. 
Include the xFade Time if Absolute is chosen.

6. Insert Merge From and Merge To times in the Set Times 
box.

7. Select the desired channels from the Channels list. The 
Select All command is a quick way to choose all channels.

8. Select Merge to perform the Merge.

9. A dialog box will appear informing you of the new Mix/Pass 
that was created. This Mix/Pass is automatically selected 
as the Play Pass.

10. Select OK to close the dialog box.
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COPY CHANNEL DATA
W 1 ______________
Seep Hix... F7
Load Hix... FI
Selete Hix...
Show His Statistics... 
Show Hix/Pass Iree... 
Clear Hix Heaury
Trio faders...
Merge Ctiannel lata...FI
Copy Channel Data...
(rase Channel la ta ...

Select Hix/Pass... F6 
Run In *R

This command allows you to duplicate channel information (fader 
moves, and/or mute events, and/or channel button events) from a 
designated channel to itself or to other channels. You may copy . 
channel information from one Mix/Pass to another and from one 
point in timecode to another. You may also specify the exact 
length of the information to be copied. The Copy command will not 
alter the Mix/Pass that you copy from or to, but will create a new 
mix, which will be displayed in the Mix/Pass area of the main 
screen. Copy is very fast, as it is done entirely in RAM, not on disk.

S O U R C E  A N D  D E S T IN A T IO N

The Mix/Pass that you want to copy information from, also known 
as the source mix, is entered in the Source box. The Mix/Pass that 
you want to copy information to, also known as the destination mix, 
is entered in the Destination box. Entering the same Mix/Pass in 
both boxes allows you to duplicate a channel’s mix information to 
the same or another channels) within that mix. It also allows you 
to copy a channel's mix information with a timecode offset. Enter­
ing a different Mix/Pass in each of the two boxes allows you to 
copy channel mix information between what could be two unrelated 
mixes.

Copy Channel Data
-Source-------

Mix Pass
□  □  

(Current Pass!

-destination--- -Include -Splice Jfode
Nix Passr— i i" ■■ i 0  Fader ®  Absolute
□  (D 0  Mute xFade tine:|l |

(Current Passl □  Ch Buttons O Relative
Set lines source S t a r t  Source End
Select fron List 0 0 : 0 0 ^ 3 : 0 1 0 0 : 0 1 : 1 7 : 2 9

Destination start
[Select fron List 0 0 : 0 1 : 4 3 : 2 5
-Set Channels-----
[ Set Source ] 
1 Channel tl
Set Destination

^

f Select hll 1

Destination Channel(s)
1 Channel *1 lt|
2 Channel S2 [1
3 Channel «3 U
* Channel M  1
5 Channel J5_________■
6 Channel 86

Channel
"  a

5-20 USERS MANUAL -  CHAPTER FIVE



IN C L U D E

The Include box allows you to select which elements are to be copied 
from a channel's mix information. You may select fader (the fader 
movements) and/or mute (the mute events) and/or channel buttons 
(the channel button events).

S P L IC E  M O D E

The Splice Mode box allows you to select whether the transitions be­
tween the source mix and the destination mix, at the copy start and 
end times, are to be Absolute or Relative. (The choice will affect the 
faders only. In both modes, the status of the mute and channel but­
tons on the destination channels) will be forced to match the source 
mix at the copy start time. At the copy end time, the status of the mute 
and channel buttons on the destination channels) will be forced to 
match the destination mix.)

A B S O L U T E

If Absolute is chosen, the destination fader(s) will crossfade 
from its own mix position to the mix position of the source fader 
at the copy start time. This is done over the frames you allo­
cate in the xFade Time box. At the copy end time, the destina­
tion fader(s) will move back to the destination mix position, once 
again occurring over the time shown in the xFade Time box.

R E L A T IV E

If Relative is chosen, the destination fader(s) will follow the 
source fader mix moves, referenced to its own mix position at 
the copy start time. In other words, the destination fader(s) will 
follow the source fader mix moves with a relative offset. At the 
copy end time, the destination fader(s) will follow the destination 
mix moves.

S E T  T IM E S

The Set Times box allows you to select the start and end points in 
timecode for the mix information to be copied. These points are re­
ferred to as Source Start and Source End. Timecode may be entered 
manually or from the Label list by choosing Select From List. The Set 
Times box also allows you to select the start point in timecode to which 
the mix information will be copied. This point is referred to as the Des­
tination Start. Once again, timecode may be entered manually or from 
the Label list by choosing Select From List.
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S E T  C H A N N E L S

The Set Channels box serves two purposes. It allows you to select the 
channel from which mix information will be copied. This is known as 
the Source Channel. Only one Source Channel may be chosen for the 
copy. The Set Channels box also allows you to select the channels) 
to which the Source Channel’s mix information will be copied. This is 
known as the Destination Channel(s). You may copy to any number of 
channels.

T O  C O P Y  C H A N N E L  DATA:

1. Select Copy Channel Data from the Mix menu.

2. Enter the source Mix/Pass in the Source box or select the 
Current Pass command button to insert the current Mix/Pass.

3. Enter the destination Mix/Pass in the Destination box or select 
Current Pass to insert the current Mix/Pass.

4. Select the channel mix information to be copied from the In­
clude box.

5. Select Absolute or Relative from the Splice Mode box. Include 
the xFade Time if Absolute is chosen.

6. Insert Source Start, Source End, and Destination Start times in 
the Set Times box.

7. Select Set Source in the Set Channels box. Select tiie desired 
channel from the Source Channel list.

8. Select Set Destination in the Set Channels box. Select the 
desired channels) from the Destination Channels list. The 
Select All command is a quick way to choose all channels.

9. Select Copy to perform the copy.

10. A dialog box will appear informing you of the new Mix/Pass that 
was created. This Mix/Pass is automatically selected as the 
Play Pass.

11. Select OK to dose the dialog box.
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ERASE CHANNEL DATA

B»l_____________
Keep Mix... F7
Load Mix... F8
delete Mix...
Show Nix Statistics... 
Show Mix/Pass Iree... 
Clear Mix Heoorjf
Trio faders...
Kerge Channel Data...F9 
Copy Channel Data...
Erase Channel Data...

This command allows you to delete channel information (fader 
moves, and/or mute events, and/or channel button events) from a 
selected channel or channels. You may erase channel information 
from any point in timecode and you may also specify the exact 
length of the information to be erased. The Erase command will 
not alter the designated Mix/Pass, but will create a new mix, which 
will be displayed in the Mix/Pass area of the main screen. Erase is 
very fast, as it is done entirely in RAM, not on disk.

E R A S E  FR O M  H E R E

Select Mix/Pass... F6 
Run On *R

The Erase From Here box allows you to choose the Mix/Pass from 
which you will erase mix information.

IN C L U D E

The Include box allows you to select which elements are to be 
erased from a channel's mix information. You may select faders 
(the fader movements) and/or mutes (the mute events) and/or 
channel buttons (the channel button events).

Erase Channel Data

tttx Pass
□  ID

(Current Pass)

~Include
ISI Faders
El Flutes
□  Ch Buttons

“Splice Bode---------------
Absolute: OxFade at Start 

©xFade at End
O  Relative

xFade 
tiwe:f i I

"Set Tines 
Select fron List Erase fron 0 0 : 0 0 : 5 3 : 0 1 Erase to 0 0 : 0 1 : 4 3 : 2 5

Channels ( Select nil ) 
[“ i Channel «1 i s

2 Channel «2
3 Channel S3 
8 Channel sa
5 Channel 85
6 Channel 86
7 Channel 87

Help! ) Cancel Erase
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S P L IC E  M O D E

The Splice Mode box allows you to select whether the transition be­
tween the mix information prior to the erased area and the mix infor­
mation following the erased area is to be Absolute or Relative. (The 
choice will affect the faders only. In both modes, the mute and chan­
nel buttons will maintain the same status as at the Erase Start time. At 
the Erase End time, the status of the mute and channel buttons will be 
forced to match the remaining mix information.)

A B S O L U T E : X F A D E  A T  S T A R T

If Absolute: xFade at Start is chosen, the fader(s) will 
crossfade from its Erase Start mix position to the Erase End 
mix position at the beginning of Erase. This is done over the 
frames you allocate in the xFade Time box.

A B S O L U T E : X F A D E  A T  E N D

If Absolute: xFade at End is chosen, the fader(s) will crossfade 
from its Erase Start mix position to the Erase End mix position 
at the end of Erase. This is done over the frames you allocate 
in the xFade Time box.

R E L A T IV E

If Relative is chosen, then at the Erase End time the fader(s) 
will follow the subsequent mix moves, referenced to its mix po­
sition at the Erase Start time. In other words, the fader(s) will 
follow the mix moves with a relative offset.

S E T  T IM E S

The Set Times box allows you to select the start and end points in 
timecode for the mix information to be erased. These points are re­
ferred to as Erase From and Erase To. Timecode may be entered 
manually or from the Label list by choosing Select From Ust.

C H A N N E L S

The Channels box allows you to select the channels) from which mix 
information will be erased.
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TO  E R A S E  C H A N N E L  DATA:

1. Select Erase Channel Data from the Mix menu.

2. Enter the desired Mix/Pass in the Erase From Here box or 
select the Current Pass command button to insert the cur­
rent Mix/Pass.

3. Select the channel mix information to be erased from the In­
clude box.

4. Select Absolute or Relative from the Splice Mode box. 
Include the xFade Time it Absolute is chosen.

5. Insert Erase From and Erase To times in the Set Times 
box.

6. Select the desired channels from the Channels list. The 
Select All command is a quick way to choose all channels.

7. Select Erase to perform the erasure.

8. A dialog box will appear informing you of the new Mix/Pass 
that was created. This Mix/Pass is automatically selected as 
the Ray Pass.

9. Select OK to close the dialog box.
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SELECT MIX/PASS

W l______________
Keep Mix... F7
Load Mix... F*
ftelete Mix...
Show Mix Statistics... 
Slto* Hix/Pass Iree... 
Clear Mix Nemry
Trio £aders...
Merge Channel lata...F9 
Kopy Channel data... 
Erase Channel lata...

This command allows you to select a desired Mix/Pass through the 
Select Mix/Pass dialog box.

N E W  M IX

This command allows you to start a new Mix/Pass branch. New 
Mix forces a new Mix/Pass number, which is useful when you want 
to create a reference point for the following Mix/Pass.

M IX  N O T E S
I Select Mix/Pass. . . F6
I Bun 8n 1 3

The Mix Notes box is used for adding comments to the current Mix/ 
Pass. Comments entered here will also appear in the Keep Mix 
dialog box.

H ID E  N O T E S /S H O W  N O T E S

This command allows you to open and close the Mix Notes win­
dow.

S e l e c t  M ix / P a s s

» x  ■ 0 D 0

E.ss I 0 0 0 0
[ »g lP' 1

[ Cancel  ̂

I Mew Mix 1 ) [ B  ]

Hide Motes"*)

TO SELECT A MIX/PASS:
1. Press MIX/PASS on the Neve V  Series Keyboard, or select 

Select Mix/Pass from the Mix menu, or dick on the Mix/ 
Pass area of the main screen.

2. Insert the Mix number and the Pass number in the text 
boxes, or use the plus and minus buttons to increment or 
decrement the Mix and Pass numbers.

3. Select OK to close the dialog box.
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TO  S E L E C T  A  M IX /P A S S  FR O M  T H E  G L O B A L  
M A S TE R :

1. The Mix/Pass numbers as they appear on the main screen 
may be changed by pressing the Plus (+) or Minus (•) but­
tons on the Global Master. To access another Mix/Pass - 
branch, use SHIFT+Plus or Minus buttons on the Global 
Master.

RUN ON/RUN OFF

m \_____________
Keep Mix... F7
Load Mix... F8
fielete Mix...
Shoo Min Statistics... 
Shoo Mix/Pass Iree... 
Clear Mix Heaory
Trin faders... 
flerge Channel Data...F9 
£opy Channel Data... 
Erase Channel Data...
Select Mix/Pass... F6
Run On

This command allows you to enable or disable automation. Auto­
mation is activated when Run is on and good timecode is being re­
ceived.

T O  T U R N  R UN O N :

1. Press RUN on the Global Master, or press CONTROL+R on 
the Neve V Series keyboard, or select Run On from the Mix 
menu, or dick the Off area on the main screen.

TO  TU R N  R U N  O FF:

1. Press RUN on the Global Master, or press CONTROL+R on 
the Neve V Series keyboard, or select Run Off from the Mix 
menu, or click the Run area on the main screen.
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OPTIONS MENU
a _________ FLVING FfiDERS
gysten £ix 1 Options 1 Transport Lists gangs flelpt

N
gnart Kegs... 
glide Tines...
Text Pages...
Set Safety Het Tines... 
Tinecode gptions... F10 
Screen Options...
Autonate Chan Buttons...

TTINSOUND STUDIOSii riiEii
RTINSOUND Technologies

Project:
Title:

| Labels |
Prev: • 11• •11 • •11 • •1111

Next: • 11 • •11• •11 • •1111

| Locate Tines |Locate|Record
1 Play from: • 1 1 1 1 • • 1 1 • • 1 1 • «

 1 1

stop at: —  — :— :— :—

Safety Nets L£ “ 1 \Capture Rollback Cycle Locate > > II
Free RAH Other Key Clide Tines Nix Pass Off Stop
101ft T rim

Auto: j 
Natch: J

Play: j £  

Rec: ___ ___ 00:00:00:00
The 'Options’ put-down menu it found on the menu bar located at the top of the mam Flying Faden screen.
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SMART KEYS
| Options |
S n ar t  K e y s . . .
glide Tines...
Iext Pages...
Set Safety Het Tines... 
Tinecode Options... Fit 
Screen Options... 
ftntonate Chan Buttons...

This command allows you to program the Smart Keys on the key* 
board. Smart Keys are an odd feature with many complicated 
behaviors. In order to use them effectively, you will need to under­
stand the issues involving Smart Keys, and how Flying Faders 
resolves these issues.

The goal of Smart Keys is to program a commonly used operation 
so that it is accessible by pressing one of the 12 keys labeled S I - 
S12 on the Neve keyboard and CTRL+(F1-F12) on the standard 
keyboard. For example, you might want key S I to set the Match 
Glide time to 30 frames and S2 to set the Match Glide time to 5 
frames. By pressing S I and S2 you could easily alternate between 
30 and 5 frames. To record the event, you tell Smart Keys to start 
recording, change the Match Glide Time, and then tell Smart Keys 
to stop recording. Unfortunately, it is not so simple. The computer 
must decide which events should be recorded and which should 
not. Using our example, we can see that many more events oc­
curred in addition to changing the Match Glide rate. After we 
started recording, we took several seconds to click on the Glide 
Times box. When the Glide Times dialog box opened, we took 
several seconds to select the rate. The whole time we were mov­
ing the mouse around and clicking on things. These things are 
also classified as events. When we click on OK we set the Match 
Glide time. In addition, whenever we set the Match Glide rate the 
Auto Glide rate is also set, yet another event.

Snart Keys

Function:
[ Record Key 

[Stop Recording] 

Clear Key ]

Snart
Key: E l Snart Key Text:
List I D E ) run false 1+1
of 2 M run true M
Snart 3 ■ tape jog -00031SOSOS ■
Keys: % ■  5 ■ run false 1

6 ■ I
7 ■ 1
> 141 171

Edit Mode:
<§> Overwrite 
O Append 
OInsert
[ Delete

Help* ) ( Exit )
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It may seem dear which events should be recorded in this ex­
ample, but every example is different. For example, we wouldn’t 
want to record the time it took to select the Glide times. But what if 
we wanted a Smart Key to reverse the transport for several sec­
onds? Then we would want to record the time lapse that occurred 
between pressing REWIND and STOP.

If we wanted to record a LOCATE/PLAY to a point on tape, we 
would start recording our Smart Key and press LOCATE followed 
by PLAY. Say that the locate time is 01:00:00. If we change the 
locate time later to 02:00:00, it is unclear whether we want our 
Smart Key to record a LOCATE to whatever the locate time is 
when we are recording the Smart Key, or to LOCATE to the current 
locate time. In other words, should it always LOCATE to 01:00:00, 
or should it always locate to the current locate time?

These issues are very complex and there is no simple solution that 
gives pleasing results all the time. Clearly, when using Smart Keys 
the events that are recorded will not always be the events you 
wanted to be recorded. We believe, however, that to best use 
Smart Keys you must understand the issues and our solutions. 
Without ttiis understanding, Smart Keys can be very confusing.

In order to understand our solution, a brief explanation of our 
system must be given. Inside the Hewlett Packard Vectra is an­
other computer called a Viper 68000. It is responsible for control of 
the automated console hardware and most aspects of automation 
(recording moves and events, editing operations, transport control, 
changing passes, saving/loading, etc...) The Vectra converts 
mouse moves and clicks into requests for the Viper. For example, 
if you dick on the Run/Off box, the Vectra asks the Viper to turn 
automation mode to Run or Off. It is this request that would be 
recorded as a Smart Key. It is not simple to understand which 
operations will be done by the Vectra alone and which operations 
require the Vectra to make a request of the Viper. Therefore, some 
trial and error will be necessary to gain an intuition for this concept. 
Note that anything you do directly on the console, apart from the 
Vectra’s keyboard, will NOT be recorded, because only requests 
that originate on the Vectra are recorded.

Here are some samples to start you off. If you dick on ROLLBACK 
with the mouse, Smart Keys will record a ROLLBACK using the 
current Rollback time. If you change the Rollback time at a later 
time, it will not affect the behavior of the Smart Key. In other 
words, if the Rollback time was 10 seconds when you recorded the
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Smart Key, the Smart Key will always rollback 10 seconds, even if 
you change the Rollback time to 20 seconds.

With automation in RUN, start recording Smart Key S I. Turn auto­
mation off (click on RUN/Off box), decrement the pass by clicking 
on t h e p a s s  key in the Select Mix/Pass dialog box. Next, turn 
automation mode back to RUN (click on RUN/Off again). Finally, 
turn the Smart Key recording mode off. Repeat this procedure on 
Smart Key S2, except click on the V  pass key. Now, while tape is 
rolling you can use keys S I and S2 to switch, on the fly, from the 
current Play/Pass to another Play/Pass without stopping tape (al­
lowing you to easily A/B passes).

There is another type of problem that occurs. Every once in a 
while the Vectra tells the Viper the current time of day to keep the 
two computers synchronized (this is only used to view the current 
time and date and has no impact on automation). The problem 
with this is that the Vectra requests the Viper to update its dock 
whenever it feels like it. If this request occurs while recording a 
Smart Key, the time would be recorded too. This is a perfect 
example of how the limited event recording scheme may some­
times record extra unwanted events.

The solution is to carefully examine a Smart Key’s contents after 
you stop recording and to make sure that it makes sense and 
would do what you want your Smart Key to do. Note that a Smart 
Key’s contents are English requests. Everything that you type in 
the Diagnostics Window is also a request. You can use the Diag­
nostics Window to cause events that you want recorded to be 
recorded in a controlled fashion. For example, when you dicked 
on t h e k e y  in the ‘Select Mix/Pass’ dialog box, the Smart Key re­
corded ‘pass -’. From the Diagnostics Window you could directly 
type ‘pass -’ and the pass counter would decrement just as if you 
clicked on the ’-’ key in the dialog box. If you were recording a 
Smart Key, it would also be recorded in the Smart Key.

Have fun and experiment Smart Keys can be very useful, but due 
to the feet that the computer has no real intelligence, it can never 
really know what you want to do. You will need to watch them 
carefully and learn how the computer thinks, if you want to get the 
most out of this feature.
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R E C O R D  K E Y

When selected, this command button starts recording the chosen 
~~~ Smart Key. Note that whatever was previously recorded into the

Smart Key will be overwritten.

S T O P  R E C O R D IN G

When selected, this command button stops recording the Smart 
Key.

C L E A R  K E Y

When selected, this command button clears a Smart Key, erasing 
any information that was recorded onto that key.

E D IT  M O D E S

The Edit Mode box allows you to choose how the Smart Key will be 
recorded. The Overwrite mode will delete any command lines 
previously recorded and replace them with newly recorded com­
mands. The Append mode will attach newly recorded commands 
to existing command lines. The Insert mode will add a newly 
recorded command(s) anywhere within previously recorded com- 
mand lines. The Delete command button allows you to eliminate a 
selected command within a command line.

T O  R E C O R D  S M A R T  K E Y S :

1. Select Smart Keys from the Options menu.

2. Insert the desired Smart Key number in the Smart Key box.

3. Select the desired Edit mode from the Edit Mode box.

4. Select the Record Key command button.

5. Perform the events that you wish to program.

6. Select the Stop Recording command button.

7. Verify the commands that were recorded.

8. Select Exit to close the dialog box.

Note...............The recorded command lines for a Smart Key may
be reviewed by selecting the Smart Key number in 

x the Smart Keys List.
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GLIDE TIMES
flptions |_ _ _ _ _ _ _ _ _ _
Swart Kegs... ~~|
Glide Tines...
lext Pages...
Set Safety Met Tines... 
Tinecode Options... Fit 
Screen Options... 
Outonate Cban (uttons...

1. Select Glide Times from the Options menu or click on the 
Glide Times area of the main screen.

2. Adjust the times as desired. A Glide Time may be changed 
by using a scroll bar or by entering the time in a text box.

3. Select OK to close the dialog box.

This command allows you to adjust the Glide rates for Match and 
the Auto Match mode. The Glide times may be changed anytime, 
even while automation is running. Because a Glide is written into . 
the fader data, a change in the Glide Time settings will not affect 
previously written Glides.

T O  S E T  G L ID E  T IM E S :

Glide Tines
Franesi

Auto Natch:
E

f Cancel ]
Hatch Button: □ [ IK j
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TEXT PAGES
Options |_ _ _ _ _ _ _ _ _ _
Snart Reps...
Slide Tines...______
Text P a q e s . . .
Set Safety bet Tines... 
Tinecode Options... FII 
Screen Options... 
flutonate Pan juttons...

This command opens the Text Pages window. Text Pages is a 
simple word processor, available for making general notes, etc. 
This window is also used for editing the following files:

1. Transport Controller Constants
2. System initialization File
3. System Diagnostics Report File

Note................ For information about editing these files, refer to the
Flying Faders Technical Manual.

TO CREATE A FILE:
1. Select Text Pages from the Options Menu.
2. Type the desired text in the text area.
3. Select Save As from the File Menu.
4. Enter the name (8 characters maximum, ending with a 

period) that you wish to save the file under. If you wish 
to overwrite an existing file, select that file from the list.

5. Select the disk that you wish to save to (Hard Disk or 
Floppy Disk).

6. Select Save to store the file to disk.
7. Select Close from the File menu to exit Text Pages.

TO OPEN A FILE:
1. Select Text Pages from the Options Menu.
2. Select Open from the File menu.
3. Select the disk that the file is on (Hard Disk or Floppy 

Disk).
4. Enter the name of the file that you wish to open or select 

the file name from the list
5. Select OK to open the file.
6. Select Close from the File menu to exit Text Pages.

TO DELETE A FILE:
1. Select Text Pages from the Options Menu.
2. Select Delete from the File menu.
3. Select the disk that the file is on (Hard Disk or Floppy 

Disk).
4. Enter the name of the file that you wish to delete or 

select the file name from the list.
5. Select Delete. A dialog box will appear asking you to 

confirm your choice. Select OK to perform the delete.
6. Select Close from the File menu to exit Text Pages.
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ADDITIONAL FILE FEATURES

NEW

New allows you to clear the window to create a new file. If the file 
that you are currently working on isn't saved when New is chosen, 
a dialog box will appear asking you if you wish to save the current 
text to its proper file.

SAVE

Save is useful for updating files. If a file is opened and edits are 
made, choosing Save will update that file.

CANCEL CHANGES

If a file is opened and edits are made, Cancel Changes will restore 
the file to the way it was after the last save.

EDIT MENU

The Edit menu is available for file editing. The Cut, Copy, Paste, 
and Clear commands allow you to delete, duplicate, and reorgan­
ize text. The Select All command highlights all the text in the file, 
so that it can be copied or cleared. The Undo command allows 
you to reverse the latest command, including Undo itself.
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SET SAFETY NET TIMES
flptions |
S*art Keys... 
Slide Tines... 
lext Pages...
Set S a fe t y  Net T i n e s . ..
Tinecode Sptions... Fit 
Screen Options... 
Automte Chan futtons...

This command allows you to set the times to be secured by Safety 
Nets. Safety Nets are used to set up a window between two points 
in timecode. Inside this window you may make new moves and/or 
events as desired, But outside of this window, the faders, mutes, 
and channel buttons are placed in the Safe mode, unaffected by 
any moves or events that may occur (accidental or otherwise).
This is desirable when you just want to make sure that data is 
protected outside of the area that you are working on.

TO SET SAFETY NET TIMES:
1. Select Set Safety Net Times from the Options Menu.

2. Go to the Safe Before box and enter the desired timecode in 
the timecode field, or select the timecode from the Label list, 
if available.

3. Go to the Safe After box and enter the desired timecode in 
the timecode field, or select from the Label list.

4. To activate Safety Nets upon closing of the dialog box, 
select Activate Safety Nets.

5. Select OK to return to the main screen.

TO USE SAFETY NETS:
1. Set the Safety Net times.

2. Turn Safety Nets on by clicking on the box labeled Safety 
Nets in the transport area of the main screen (the box will 
turn yellow).

3. Place the tape into play (the box will turn green).

4. When the Safe Before time is reached, Safety Nets will be 
turned off (the box will turn red) and any moves or events 
made will be recorded. When the Safe After time is reached, 
the faders will Match to their original Ray Pass position (the 
box will turn green again). A new Mix/Pass will be created, 
and no additional moves or events will be recorded.

N ote.............. If tape (timecode) is stopped before the Safe After
time occurs, the faders, mutes, and channel buttons 
will still Match to the Play Pass Position at the Safe 
After time.
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TIMECODE OPTIONS
Options 
Snort Keys...
£lide Tines...
Iext Pages...
Set Safety Bet Tines...
T i n e c o d e  O p t i o n s . .. F10
I Screen Options... 
|dotonate Chan juttons...

This command allows you to choose timecode type, timecode 
display options, and local zero times.

TIMECODE TYPE

The Timecode Type box contains choices of 24 ,25 , and 30 (drop 
or nondrop) frames per second. Note: Flying Faders does not 
automatically determine the incoming code type. The default is set 
via the System Initialization File for the type of code you most often 
use, so check its setting before you start mixing (refer to the Tech­
nical Manual). If you forget, and the incoming code differs from 
what is set, a dialog box will appear informing you of this.

THE TIMECODE INDICATOR

The SHIFT button light on the Global Master serves as the time- 
code indicator. If the light is on solid, this indicates that valid time- 
code is being received. If the light is flashing, the system is receiv­
ing flakey timecode, and if the light is completely off, no code is 
being received. If the system is indicating that flakey or no time- 
code is being received, check to make sure that timecode is 
patched into Flying Faders and confirm that the timecode type is 
correct.

TO SET THE TIMECODE TYPE:
1. Press CODE on the Neve V  Series keyboard, or select 

Timecode Options from the Options menu, or click on the 
timecode field in the lower right comer of the main screen.

2. Select desired timecode from the Timecode Type box.

3. Select OK to dose the dialog box.

T in ec ode  O pt io ns

'Tinecode Foraat— 'Display Options—
O  2* fps □  Hide Hours
0  25 fps □  Hide Franes
O  38 fps (drop)
<§>|3B fps (nondrop!

'Local Zero 
□  Local Zero ON Jtelpt

1 • •
 1 1 • • • •
 1 [ Cancel

( Select fron List I _ J
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DISPLAY OPTIONS

The Display Options box allows you to mask the hours and/or 
frames on all timecode displays.

Note...............Full entry of timecode is required even if the hours
and/or frames are suppressed.

TO SET THE DISPLAY OPTIONS:
1. Press CODE on the Neve V Series keyboard, or select 

Timecode Options from the Options menu, or click on the 
timecode field in the lower right comer of the main screen.

2. Select the desired display alternatives from the Display Op­
tions box.

3. Select OK to close the dialog box.

LOCAL ZERO

This feature is used to display the running time of a mix, versus the 
timecode in use. Local Zero allows you to set a user-friendly 
reference to any point in timecode. When Local Zero is activated, 
running code will be offset so that the chosen point is displayed as 
00:00:00:00 in all timecode fields. Timecode may be entered 
manually or from the Label list by choosing Select From List.

TO SET LOCAL ZERO:
1. Press CODE on the Neve V  Series keyboard, or select 

Timecode Options from the Options menu, or click on the 
timecode field in the lower right comer of the main screen.

2. Insert the desired timecode.
3. Select Local Zero ON.
4. Select OK to dose the dialog box.

Or

1. Click on Capture in the Local Zero area of the main screen 
at the desired point in timecode. This may be done on the 
fly or with timecode stopped.

2. Click on the Local Zero area to turn Local Zero on or off.

Note...............Local Zero is saved and automatically reloaded
with the Mix.
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SCREEN OPTIONS

flptions |_ _ _ _ _ _ _ _ _ _
Snart Keys...
Slide Tines... 
lext Pages...
Set Safety Net Tines... 
Tinecode flptions... F1I
Serpe n  O p t i cus...
[dutonate Clwn jdttons...|

This command allows you to alter the look of the Flying Faders 
VDU for your personal tastes. In no way is automation affected by 
these commands.

USING SCREEN OPTIONS:
1. Select Screen Options from the Options menu.

2. Select the desired border color and captions style.

3. Select OK to close the dialog box.

Screen O p t io n s  !

Border O  White
Color: €>15153

Transparent O V e s  
Captions: ^

1____ _________! Cancel [ OK ]
______________________________________________________________________
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AUTOMATE CHANNEL BUTTONS

Options 
$nrt Keys...
Slide Tines... 
lest Pages...
Set Safety flet Tines... 
Tinecode Options... F1I 
Screen Options...____
A u t o n a t e  Utian b u t t o n s . ..

Automate Channel Buttons allows you to enable and disable the 
four channel buttons and the cut A/B Bus on any given channels).

T O  A U T O M A T E  C H A N N E L  B U T T O N S :

1. Select Automate Channel Buttons from the Options menu

2. Select the button(s) to be automated.

3. Select the channels) to be automated.

4. Select OK to return to the main screen.

N ote.............. This feature is for use with Neve consoles equipped
with events.

fiutonate Channel Buttons
“Automate These* 
Huttons:
EJEQ

SI Insert
SI Hon Cut
IS Chan Cut
G Cut A U  Bus

On These Channels 
( Select Oil )
1 Channel #1
2 Channel 82
3 Channel 83
h Channel 88
5 Channel 85
6 Channel 86
7 Channel 87
8 Channel 88
9 Channel 89

Help

Cancel

I °« I

>
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TRANSPORT MENU

FLVING FfiDERS

Systen Mix flptions Transport | lists gangs Help!

Project:
Title:

Labels

Set locate Tines...
Set Rollback Tine...
Set Reel £tart ft End Tines.

Set Ruto Record Til 
Auto Record On

Select Transport...
Reset Transport Controller

ND STUDIOS

” A » B
ND Technologies

preu: —

Next:------  1---- J----J
Locate Tines
Play fron: 

Stop at:

Safety Nets [1Capture Rollback Cycle Locate »  >  II
Free RAH irn.u j h j h Glide Tines Hlx PaiT Off Stop
101ft Trim

Auto: | 
Hatch: j

Play: j £  
Rec: [i ___ 00:00:00=00

The ’Trmntporf pt̂ -down menu it  found on the menu bar locmted mt the top of the main Flying Fadersecreen.
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TIMES
| Iraasport |
Set Locate Tines...
Set Rgllback Tine...
Set Reel Start t E M  I 1m s ...
Set Rute Record Tines... 
Rate Record Bn
Select Iraasport...
Beset Transport Controller

This command allows you to edit the Locate Times. The Locate 
Times are used in conjunction with the Cycle and Locate com­
mands on the main screen, providing an autolocator for the trans-.. 
port.

Note ..— .... The optional transport controller must be interfaced 
to use this dialog box.

P L A Y  FR O M

The Play From time is the point in timecode to which the tape 
transport will locate, when the Locate or Cycle command is acti­
vated from the main screen or the keyboard. Times or labels may 
be entered manually or selected from the Label list.

S T O P  A T

The Stop At time is the point in timecode at which the tape trans­
port will stop during play; and rewind when the Cycle command is 
activated. Times or labels may be entered manually or selected 
from the Label list.

P R E R O L L

Preroll allows you to apply a fixed offset from the Play From time to 
cause the tape to locate to a point that much earlier. This is useful 
when synchronizing multiple machines.

T O  S E T  L O C A T E  T IM E S :

1. Select Set Locate Times from the Transport menu, or click 
on the Locate Times box on the main screen.

2. Enter the desired timecode in the Play From timecode field.

3. If a countdown to the punch in point is desired, enter the 
time in the Preroll timecode field.

4. Enter the desired timecode in the Stop At timecode field.

5. Select OK to dose the dialog box.

N o te .............. The Play From or Stop At time may be entered di­
rectly from the main screen by clicking on either time- 
code field or label number field in the Locate Times 
area.
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T O  S E T  L O C A T E  T IM E S  FR O M  T H E  N E V E  V  S E R IE S  
K E Y B O A R D :

In addition to setting the Locate Times via the Set Locate Times dialog 
box, they may be set directly from the Neve V Series keyboard. Here 
are some examples:

LOCATE 3 PLAY (Press LOCATE, followed by 3, followed by PLAY) 
-Locates to label 3, then plays.

LOCATE (right arrow) 1 2 1 2 1 2 1 2 PLAY or STOP
-Locates to this timecode (12:12:12:12), then plays or stops.

LOCATE + 1015 PLAY or STOP
-Locates 10 sec, 15 frames ahead, then plays or stops. A 
backwards locate is done if - is used instead of +.

LOCATE 3 TO 4 PLAY or STOP
-Similar to LOCATE 3 PLAY, but in addition, sets Stop At Point 
(TO Point) to label 4.

LOCATE 3 TO (right arrow) 1 2 1 2 1 2 1 2  PLAY or STOP
-Locates to label 3 and sets the Stop At time to 12:12:12:12.

Set Locate Tine'

Play fron:—  
Label 1: 
INTRODUCTION 01:00:15:11

01:00:15:11 INTRODUCTION
2 01:00:1(7:23
3 01:01:35:29
4 01:02:24:05
5 01:03:01:21
6 01:03:49:27

UERSE 1 
UERSE 2 
CHORUS 1 
UERSE 3 
CHORUS 2

Preroll (sec): 00:00:05:00

Stop at:-
Label 6: 
CHORUS 2 01:03=49:27

1 01:00:15:11 INTRODUCTION 1+]
2 01:00:47:23 UERSE 1 [J
3 01:01:35:29 UERSE 2 ■
4 01:02:24:05 CHORUS 1 ■
5 n :  ©3:01:21 UERSE 3 ■
6 0 1 : 0 3 : * * 9 : 2 7 CHORUS 2  □

[ Help* ][ Cancel ]f Bk
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SET ROLLBACK TIME
jransport_ _ _ _ _ _
Set Locate Tines...
Set Rollback Tine...
Set Reel Start fc End Tines...
Set Auto lecord Tines... 
Buto Record On
Select Iransport •••
Reset Transport Controller

This command allows you to set a timecode amount which the 
transport will rewind during a Rollback. When the Rollback com­
mand is activated from the main screen or the keyboard, the trans­
port will rewind the preset time and then drop into play.

Note ............ The optional transport controller must be interfaced
to use this dialog box.

T O  S E T  R O L L B A C K  T IM E :

1. Select Set Rollback Time from the Transport menu.

2. Enter the desired Rollback Time in the timecode field.

3. Select OK to close the dialog box.

Set Rollback time

fiollback tine:

00:00=10:00
[ Helpf )
[ Cancel — '

t flK )
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SET REEL START 
AND END TIMES
jransport______
Set Locate Tines... 
Set tailback Tine...
Set Reel Start & tnd Tines...

Set duto Record Tines... 
Ruto Record On
Select Iransport...
Reset Transport Controller

This command allows you to inform the system of timecode points 
near the beginning and end of the reel. The system will then pre­
vent the tape from inadvertently rewinding or fast-forwarding past 
these points.

Note.................The optional transport controller must be interfaced
to use this dialog box.

T O  S E T  R E E L  S T A R T  A N D  E N D  T IM E S :

1. Select Set Reel Start and End Times from the Transport 
menu.

2. Enter the desired time in the Start of Reel timecode field.

3. Enter the desired time in the End of Reel timecode field.

4. Select OK to close the dialog box.

Set Reel Start & End Tines
rStart oF reel: rEnd of reel:
Label 1: 
INTRODUCTION

2
3
4
5
6

0 1 :00:15:11
01:00:47:23
01:01:35:29
01:02:24:05
01:03:01:21
01:03:49:27

0 1 : 0 0 : 1 5 : 1 1
INTRODUCTION
UERSE 1 
UERSE 2 
CHORUS 1 
UERSE 3 
CHORUS 2

Label 6:
CHORUS 2

1 01:00:15:11
2 01:00:47:23
3 01:01:35:29
4 01:02:24:05
5 01:03:01:21
6 01:03:49:27

0 1 : 0 3 : 4 9 : 2 7
INTRODUCTION 
UERSE 1 
UERSE 2 
CHORUS 1 
UERSE 3
CHORUS 2

. Jjelpt ~ ] [  Cancel )[ OK )
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SET AUTO RECORD TIMES
Iransport |_ _ _ _ _ _ _ _ _
Set Locate Tines...
Set Rollback Tine...
Set Reel Start I End Tines.,
Set fiuto Record Tines...
fiuto Record in
Select Iransport...
Reset Transport Controller

This command allows you to set points in timecode between which 
the transport will automatically punch in and punch out. This is an 
especially useful command when a tight in and out is required for 
an overdub. When the Auto Record Times are displayed on the 
main screen, Cycle and Locate use these times to perform their 
functions. Clicking on Record or Locate, in the upper right comer 
of the Locate Times area, toggles between Locate Times and Auto 
Record Times.

N o te ............. The optional transport controller must be interfaced
to use this dialog box.

P R E R O L L

Upon entering a Record In time, the Locate and Cycle commands 
will play from this point. As a “running start" countdown will likely 
be desired before the punch in point, a time can be entered here to 
specify the length of the countdown.

P O S T R O L L

Upon entering a Record Out time, the transport will either stop or 
Cycle at this point. As it is generally desired to play through the 
Record Out point, a selectable Postroll is provided.

Set Auto Record Tines
’Record in:—  
Label 1: 
INTRODUCTION 0 1 : 0 0 : 1 5 : 1 1 .0

HI:0B:15:11 INTRODUCTION
2 01:00:47:23
3 n:ti:35:29
4 01:02:24:05
5 01:03:01:21
< 01:03:49:27

UERSE 1 
VERSE 2 
CHORUS 1 
UERSE 3 
CHORUS 2

Preroll (sec): 0 0 : 0 0 : 0 5 : 0 0

At record in O  record. |
point, ... @  hold RECORD VERIFY
________________to confirm.________|

rRecord out:'
Label
UERSE

5:
3 0 1 : 0 3 : 0 1 : 2 1 .0

1 01:00:15:11 INTRODUCTION |±
2 01:00:47:23 UERSE 1 r
3 01:01:35:29 UERSE 2 ■
4 01:02:24:05 CHORUS 1 ■
5 01 : 03 : 01 :21 UERSE 3

I 6 01:03:49:27 CHORUS 2 J±)

Postroll (sec): 0 0 : 0 0 : 0 3 : 0 0

[ Help! | [ Cancel ) ( jflKj )

7-8 USERS MANUAL - CHAPTER SEVEN



R E C O R D  V E R IF Y

During Cycle, with Auto Record enabled, you may not want the 
transport to go into record with each cycle without confirmation 
from you. Choosing Record Verily will allow you to confirm if file 
transport should go into record when the punch in point is reached. 
Confirmation is accomplished by pressing the RECORD button on 
the Neve V  Series keyboard while playing through the Record In 
point. If Record is selected, a record command will be issued 
without confirmation when the punch in point is reached.

T O  S E T  A U T O  R E C O R D  T IM E S :

1. Select Set Auto Record Times from the Transport menu, or 
click on the Auto Record Times area on the main screen.

2. Enter the desired timecode in the Record In timecode field, 
or select the time from the Label list.

3. If Preroll is needed, enter the desired time in the Preroll 
timecode field.

4. Enter the desired timecode in the Record Out timecode 
field, or select the time from the Label list.

5. If Postroll is needed, enter the desired time in the Postroll 
timecode field.

6. Select Record or Record Verify.

7. Select OK to close the dialog box.

N ote.............. The Auto Record times may be updated by clicking
directly on the Record In and Record Out timecode 
fields in the Auto Record area of the main screen.

TRANSPORTMENU 7-9



AUTO RECORD ON / 
AUTO RECORD OFF
jransport |_ _ _ _ _ _ _ _ _
Set Locate Tines...
Set Rollback Tine...
Set Reel Start I End Tines..
Set into Record Tines...
ftuto Record On

Select Iransport...
Beset Transport Controller

This command allows you to turn Auto Record on and off. When 
enabled, a red and yellow box will appear, telling you that Auto 
Record is on. When the transport is put into play, a countdown 
(part of the preroll) to Record In will be displayed. When the trans­
port automatically goes into record, the Auto Record On box will 
turn completely red. A countdown to Record Out will then be 
displayed.

N o te .............' The optional transport controller must be interfaced
to use this dialog box.

T O  T U R N  A U T O  R E C O R D  O N :

1. Set the Auto Record Times.

2. Press AUTO REC on the Neve V  Series keyboard, or select 
Auto Record On from the Transport menu.

3. Place the transport into play.

N o te ----------- Auto Record will not turn on unless you have al­
ready set the Record In/Record Out times.

T O  T U R N  A U T O  R E C O R D  O F F :

1. Press AUTO REC on the Neve V  Series keyboard, or select 
Auto Record Off from the Transport menu, or click on the 
Auto Record On box.

SELECT TRANSPORT

jransport |_ _ _ _ _ _ _ _ _ _
Set Lecate Tines...
Set Rollback Tine...
Set Reel Start I End Tines...
Set Rnto Record Tines. 
Ruto Record In

This command allows you to select the constants for the tape 
transport to be used with Flying Faders.

Note ............ The optional transport controller must be interfaced
to use this dialog box.

T R A N S P O R T  C O N T R O L  E N A B L E D
Select Iransport...
|Beset Transport controller] This command determines if the transport will be controlled by the

Flying Faders transport controller.
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T O  S E L E C T  T H E  TR A N S P O R T :

1. Select Select Transport from the Transport menu.

2. Select the desired tape machine from the list.

3. Select Transport Control Enabled.

4. Select OK. A dialog box will appear to inform you that the 
constants for the chosen tape machine are set.

5. Select OK to close the dialog box.

6. Select Reset Transport Controller from the Transport 
menu.

Select Transport

EH {Transport Control Enabled!
Current Transport Device: No device currently selected
Transports:
Akai HG1212 I5ips 
Anpex AG-**BC 15ips 
Anpex ATR-100-1M 7.Sips 
Anpex ATR-108-10* 15ips 
Anpex ATR-100-10* 3Dips 
Anpex ATR 116/12* 15ips 
Anpex NH-1200 15ips 
Anpex HN-1200 3Dips 
Anpex UPR 2/UPR 00 
Fostex B-16 (PC Capstan) ISips

Help!

Cancel ]

fik J

RESET TRANSPORT 
CONTROLLER

Iransport |
Set Locate Tines...
Set tailback Tine...
Set keel Start I End Tines.
Set kuto (ecord Tines... 
Auto Record On
Select Iransport...
Reset Transport Controller

This command allows you to reset the transport controller without 
performing a total system reset.

N ote................ The optional transport controller must be interfaced
to use this dialog box.

TO  R E S E T  T R A N S P O R T  C O N T R O L L E R :

1. Select Reset Transport Controller from the Transport menu.

2. The transport controller will reset and a dialog box will ap­
pear informing you that the cunent tape machine constants 
have been set.

3. Select OK to close the dialog box.
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LIST MENU

B FLVINC FADERS
Systen j|ix fptions Iransport Lists | fangs flelpt

Label List... FI 
Capture Hark Tine ~K STUDIOS

. M B S
Technologies

Channel Hanes...
Channel Button Hanes__

Project:
Title: Hute List... F2 

Chan Button List__ F3
Labels Cut B/B Bus List...

Next: —  

Locate Tines 
Play fron: —

I • I

• • •
1Locate|Record

Stop at:

Safety Nets 1Capture Rollback Cycle Locate ^ »  >  II
Free RAM Other Key Clide Tines Mix Pass Off Stop
100k T rim

Auto: j 
Match: j

Play: ^ 2  

Rec: . ___ 00:00 :00 :00
The ‘Lists’ puB-down menu is found on the menu bar located at the top of the main Flying Faders screen.
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LABEL LIST

Capture HarK Tine
FI
*K

Channel Nanes... 
Channel Button Hanes...
Mute List... F2
Chan Button Llst...F3 
Cut ft/B Bus List...

The Label List allows you to capture a point in timecode and assign 
a number and a name to it. Labels are not a necessity, but a con­
venience for performing system operations. The Label List ap­
pears throughout the Flying Faders program, providing an alternate 
method of timecode selection. Labels in the list are arranged by 
their location in timecode, not by their Label number.

N E W

This command allows you to create a label for the point in time- 
code that is displayed in the timecode area of the main screen. 
This is very useful for creating labels on the fly.

T O  C R E A T E  A  N E W  L A B E L :

1. Press LABEL on the Neve V Series keyboard, or select 
Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select New at the point in timecode that a label is desired.

3. Select OK to dose the dialog box.

Note ............ A new label may be created without opening the
Label List dialog box by pressing NEW LABEL on 
the Neve V  Series keyboard.

M O D IF Y

This command allows you to edit labels contained in the Label list.

T O  M O D IF Y  A  L A B E L :

1. Press LABEL on the Neve V  Series keyboard, or select 
Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select the Edit Labels option button.

3. Select the label that you wish to edit. It will appear in the Se­
lected Label box.

4. Modify the chosen label. Any part of the label may be ed­
ited.
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5. Select the Modify command button and the label will be 
placed on the list in its proper place in timecode.

6. Select OK to close the dialog box.

N ote.............. If you decide to cancel a change, be aware of the
fact that CANCEL will erase all changes made from 
the time the Label List dialog box was opened.

D E L E T E

This command allows you to remove a label from the Label list.

T O  D E L E T E  A  LA B E L:

1. Press LABEL on the Neve V Series keyboard, or select 
Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select the Edit Labels option button.

3. Select the label that you wish to delete. It will appear in the 
Selected Label box.

4. Select the Delete command button and the label will be re­
moved from the list.

5. Select OK to dose the dialog box.

N ote.............. If you decide to cancel a change, be aware of the
fact that CANCEL will erase all changes made from 
the time the Label List dialog box was opened.

Label List
Nun Tine Name
1 01:00:15:11 INTRODUCTION
2 01:00:1)7:23 UERSE 1
3 01:01:35:29 UERSE 2
% 81:02:21i:05 CHORUS 1
5 01:03:01:21 UERSE 3
6 01:03:49:27 CHORUS 2■D 0 1 :04:?7:13 INSTRUMENTAL BREAKnr 01:04:45:22 REGIN FADELL 01:05:36:03 END OF FADE 1

fidd jyew

Qelete Help?
modify Cancel

Delete All m

'Select
m

ed Label:
L lJ

0 1 : 0 4 : 2 7 : 1 3 INSTRUMENTAL BREAK

®  Edit Labels
O  AutoScroll list 

with Timecode
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A D D

This command allows you to manually enter a label number, its 
position in timecode, and to name it.

T O  A D D  A  L A B E L:

1. Press LABEL on the Neve V  Series keyboard, or select 
Label List from the Lists menu, or click on the Labels area 
of the main screen.

2. Select the Edit Labels option button.

3. Enter the label number in the left text box of the Selected 
Label box. (Labels may not be added without a label num­
ber.) Use Next to automatically use the next available label 
number.

4. Enter the desired timecode in the timecode field.

5. Enter the label name in the right text box of the Selected 
Label box.

6. Select the Add command button.

7. Select OK to dose the dialog box.

N o te ............. If you decide to cancel a change, be aware of the
fact that CANCEL will erase all changes made from 
the time the Label List dialog box was opened.

O T H E R  C O M M A N D S

Next-Automatically increments the label number, going to the 
next label on the list.

Delete All-Erases all labels. (Followed by a Yes/No dialog 
box.)

AutoScroll-As tape plays, the highlight bar moves through the 
Label List box, highlighting the labels when their point in time- 
code is reached.
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CAPTURE MARK TIME
I L is ts  |_______________
I Label L is t . . .  TT|
Capture Hark line ~K

Channel H anes... 
Channel Button Hanes...

Bute L is t . . .  F2
Chan Button L is t.. .F 3  
Cut ft/B Bus L is t . . .

Capture Mark Time takes the timecode displayed at the time this 
command is chosen and adds it to the Label list as label number 
zero. This is a very useful “quick label” feature, but be aware of 
the fact that the next time this command is selected, the previous 
Mark label will be overwritten.

T O  C A P T U R E  M A R K  T IM E :

1. Press MARK on the Neve V Series keyboard, or select Cap­
ture Mark Time from the Lists menu.

2. The timecode that is displayed at the time of selection is 
added to the Label list, along with the Mark title.

CHANNEL NAMES
This command allows you to assign a name to each of the chan­
nels. Channel names are not a necessity, but a convenience for 
performing system operations. Channel names appear throughout 
the Flying Faders program, providing a convenient way to differen­
tiate channels.

T O  N A M E  A  C H A N N E L :

1. Select Channel Names from the Lists menu.

2. Select the desired channel.

3. Add to or edit the name in the text box.

4. Select the Name command button to add the name to the 
list.

5. Select OK to close the dialog box.

L is ts  |_______________
Label L is t . . .  F I
Capture Hark Tine ~K

Channel Namps...
Channel Button Hanes...

tfu te  L is t . . .  F2
£han Button L is t  F3
Cut ft/B  Bus L is t . . .
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CHANNEL BUTTON NAMES
Lists_____________
Label List... FI 
Capture Hark Tine *K
£hannel Nanes...
ChannelButtor: Names...

This command allows you to assign a name to each of the four 
channel buttons that are monitored by Flying Faders. This is not a 
necessity, but a convenience for performing system operations.

N o te ------------------- This feature is for Neve consoles with Events.

ifute List... F2 
Chan Button List... F3 
Cut >/B Bus List...

T O  N A M E  A  C H A N N E L  B U T T O N :

1. Select Channel Button Names from the Lists menu.

2. Select the desired channel button.

3. Add to or edit the name in the text box.

4. Select OK to close the dialog box.

EVENT LISTS

L is ts  |_______________
Label L is t . . .  FI 
Capture Hark Tine “ K

Channel H anes... 
Channel Button Hanes. . .

Mute L i s t ... \ 2
Chan Button Llst...F3 
I Cut ft/B Bus List... |

The Mute, Channel Button, and the Cut A/B Bus Lists allow you to 
view and edit events for mutes, channel buttons, and the cut A/B 
bus. The list that appears when the box is first opened is deter­
mined by your menu selection. All three lists may not be viewed 
simultaneously, but may be changed via a sub-dialog box or by 
returning to the main menu. Events may be viewed or edited by 
the type of event, the channel on which the event occurred, and/or 
their location in time.

Note ............ The Channel Button List is for use with Neve con­
soles that are equipped with events.

S C R O L L IN G  T H E  E V E N T  L IS T S

The buttons directly to the right of the list are used to scroll the list.

B eg........ Displays the beginning of the list
16- ........ Moves the list backwards by 16 events
4- .......... Moves the list backwards by 4 events
4+ .......... Advances the list by 4 events
1 6 + ........ Advances the list by 16 events
End........ Displays the end of the list
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V IE W  E V E N T S

This box, which is located on the right side of the screen, allows you to 
choose what the event list will display. Events may be viewed on all or 
selected channels. The system default is set to show all channels, but 
any channels) may be selected to be displayed. The option button 
labeled On Selected Channels enables the channel selections that 
were made in the Select View sub-dialog box.

Mute List
Tjnecode

01 03:09:11.0 2 Mute off Channel 0201 03:10:01.1 1 Mute on Channel 0101 03:11:06.2 1 Mute off Channel 11 >
01 03:11:13.0 2 Mute on Channel 8201 03:35:18.0 0 Mute on Channel 00 I01 03:36:25.0 O Mute off Channel 00 [01 03:39:20.2 5 Mute on Channel 05 I01 03:00:20.1 O Mute on Channel 0001 03:00:21.1 5 Mute off Channel 0501 03:06:15.0 3 Mute on Channel 03 r
01 03:06:15.3 O Mute off Channel 00 1
01 03:57:10.1 2 Mute off Channel 02 >
01 03:57:15.3 3 Mute off Channel 03
01 00:02:23.0 8 Mute on Channel 08
01 00:06:06.1 8 Mute off Channel n
01 00:08:07.3 7 Mute on Channel *7

t
0 1 : 0 3 : 0 4 : 2 5 .0

linecode — (Select hjpEhannel — RSelectO~|
n

leg

16-

0-

0
16*

End

rfcuent---------------
®  Mute

O EQ O Insert
O Mon Cut O Chon Cut
OCut ft OCut B

Jliev Events— |
© O n  oil 

channels
O  On selected 

channels
[Select Uieg)
[current Tine]

C feelete

[ fiodify ] 

[ fldd

Helpt )

DExit

S E L E C T  V IE W

The Select View command button opens a sub-dialog box, 
which is used for choosing channels to be displayed and for 
changing the type of event to be displayed. This dialog box 
may also be used to locate a specific time that an event oc­
curred on.

N E A R  T H IS  T IM E

This box allows you to locate an event contained in the list. 
The default time is the current tape location. If a different 
time is desired, it may be entered directly in the timecode 
field or selected from the Label List by choosing Select 
From List.
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VIEW THESE EVENTS

This section of the Select View dialog box allows you to 
choose any of the three event lists without having to re­
select them from the main screen menu. The right side of 
the box allows you to select any of the four channel buttons' 
for viewing. The View All Channel Buttons command button 
selects all the buttons simultaneously.

~Uiew These Events-
O  Mutes fUiew a ll  Channel Buttons)
©Channel Buttons: E Ieq □  Mon Cut
Q C ut Bus □  Insert □  Chan Cut

~0n These Channels
( Select O il )

p r Channel n  +
L i _ Channel «23 Channel «3

a Channel M  |
5 Channel •5 ■
6 Channel •6 I
7 Channel ■
8 Channel «8 [71

Helpt

[ Cancel 1
[ OK J

ON THESE CHANNELS
This section of the Select View dialog box allows you to 
assign the channels to be displayed for the lists. The Select 
All command button may be chosen to quickly select all 
channels. Channel selections are retained when another list 
is displayed.

CURRENT TIME

The Current Time command button places the event closest to the 
current timecode in the center of the list. Any new events that 
occur while automation Is on will also be added to the list with this 
command.

N o te ............ Normally the list isn’t updated until automation is
turned off, but the Current Time command adds 
events that are created while tape (timecode) is 
running.
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TIMECODE

This box allows you to edit timecode. This is useful for changing 
the timecode of an existing event, or for adding an event. You may 
select times from the Label List by choosing Select From List, or if 
the desired time doesn't exist in the Label List, it may be entered 
directly in the timecode field.

CHANNEL

This section is for designating the channel on which events or 
event edits will occur. Channels may be chosen by entering the 
channel number directly in the box or by choosing Select, which 
calls up the Channel Names dialog box.

STATUS

This box is used to select the state of an event that is to be added 
or modified. Any given event may be configured to be on or off.

EVENT

This section of the list allows you to choose events for editing. The 
events that are highlighted in this box are the events that are cur­
rently being displayed in the list. Edits may be made to any of the 
events (highlighted or grayed), regardless of the event list that is 
displayed. Any event edit that occurs is immediately updated by 
Flying Faders.

ADD

This command allows you to insert events into the Event Lists.
You may add events to the channel mute, the four channel buttons, 
or to the cut A/B bus. These buttons may be configured to be on or 
off.

A

TO ADD TO THE EVENT LISTS:

1. Select the desired event list from the Lists menu (Mute, 
Channel Button, or Cut A/B Bus).

2. Enter the time that you wish the event to occur on in the 
timecode field of the Label box.
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3. Select or enter the channel number that you want the event 
to be added to from the Channel box. (This step is unnec- 
essary if you are adding a cut bus event.)

3. Select the event state from the Status box.

4. Select the desired event to be added from the Event box.

6. Go to the View Events box and select the channels) that 
you wish to add events to (so that you can see existing 
events and verify the add).

7. Select Add to insert the event.

8. Select Exit to return to the main screen.

MODIFY

This command allows you to edit items in the Event Lists. Time-
code, channel number, status, and event type may all be changed.

Note ............ To change the channel names and the channel
button names, refer to “Channel Names” and 
"Channel Button Names" in this chapter.

TO MODIFY THE EVENT LISTS:

1. Select the desired event list from the Lists menu (Mute, 
Channel Button, or Cut A/B Bus).

2. Select the entry that you wish to modify from the list. The 
Timecode, Channel, Status, and Event boxes will all be 
changed to match the selected entry.

3. Make the desired edits to these boxes.

4. Select Modify to initiate your changes.

5. Select Exit to return to the main screen.

DELETE

This command allows you to remove events from the Event Lists.

TO DELETE FROM THE EVENT LIST:

1. Select the desired event list from the Lists menu (Mute, 
Channel Button, or Cut A/B Bus).
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2. Select the desired entry or entries from the list. 
(SHIFT+Click and drag to select multiple entries.) Events 
that were previously selected, but no longer shown in the 
window are de-selected.

3. Select Delete and the event will be removed from the Event 
List.

4. Select Exit to return to the main screen.

J t
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GANGS MENU

FLYING FADFRS

Systew flix  flptions Iransport L ists fiangs^^elp^

N
Project:

T it le :

P L 1

Coalesce Croups... 
Suspend Groups

Clear Croups 
Clear Links
Clear Croups and Links

OS

logies

Labels

Preu:

Next:

Locate Tines |Locate|Record
Play fron: 

Stop a t:

Safety Nets Local
Zero Capture Rollback Cycle Locate I I

I fTHilJ MUJII

100* T rim

Glide Tines
Ruto: |

Natch: f

Sx Pass
Play:

Rec:
1 2

Off Stop
00:00:00:00

The 'Gangs" putt-down menu is found on the menu her heated at the top of the mein Flying Faders screen.
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COALESCE GROUPS

|I»I«|S|
Coalesce Croups...
Suspend Croups

Clear £roups 
Clear Links 
£lear Croups a links

Coalesce Groups allows you to copy all of the moves and mutes of 
a Group master to that master’s slaves, creating a new Mix/Pass. 
The slave’s moves and mutes in the resultant Mix/Pass are the 
sum of their recorded moves plus the moves of the slave’s previ­
ous master.

N o te ______  Since Coalesced Groups are disbanded, the slaves
in previous Mix/Passes will only play back data that 
was recorded on their individual channels.

M A S T E R S

This area of the dialog box allows you to assign the Group(s) to be 
Coalesced by choosing its Group master.

C O A L E S C E  C H A N N E L  D A T A

This section allows you to choose whether or not subgroups are to 
be Coalesced along with the subgroup’s master. If Group masters 
are Coalesced, but not their submasters, the submaster’s Group 
structure will remain intact, continuing to follow the moves of the 
Group that was Coalesced.

Note ......— .. If you wish to Coalesce specific subgroups in a
Group, but not others, choose “from selected mas­
ters ONLY" and highlight the desired submasters 
along with their master.

Group Coalesce
Masters C Select All 1

3 Channel «3 Ijh] ‘Coalesce Channel Data
4  Channel 3 4  M
7 Channel «7 ■ ®  fro* selected Rasters Help? ]
8 Channel #8 1 ONLY - - ---- J

1 Ofro* selected Rasters Cancel
I AND their subRasters r  t------- - -

_ __________________________ s
1 {Coalesce!
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T O  C O A L E S C E  G R O U P S :

1. Select Coalesce Groups from the Gangs menu.

2. Select the desired Group masters from the Masters box.

3. Select the data to be Coalesced from the Coalesce Channel 
Data box.

4. Select the Coalesce command button and a new Mix/Pass 
will be created, containing the new information.

5. A notice box will appear, informing you of the new Mix/Pass 
that was created.

SUSPEND GROUPS

£angs
Coalesce Croups... |
Suspend Groups

This command allows you to temporarily disable all Groups. This is 
most useful when you need to Trim a Group master without Trim­
ming that master’s slaves.

Clear £roups 
Clear links 
Clear Croups « Links

T O  S U S P E N D  G R O U P S :

1. Select Suspend Groups from the Gangs menu. A notice box 
will appear, informing you that Groups have been sus­
pended. A check will also appear in front of the Suspend 
menu listing.

2. Make desired adjustments to the fader levels.

3. Select Suspend Groups from the Gangs menu once again. 
A notice box will appear, informing you that Groups have 
been enabled.

Note...............Groups may also be Suspended from the Trim
Faders dialog box. Refer to Chapter 5, ‘Trim Fad- 
ers”, for more information.
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CLEAR GROUPS

gangs
Coalesce Groups... 
Suspend Groups

Clear Groups
Clear Links 
Clear Groups a Links

This command allows you to delete all Groups currently in use.

T O  C L E A R  G R O U P S :

1. Select Clear Groups from the Gangs menu.

2. A dialog box will appear asking to verify your request.

3. Selecting OK will clear all Groups and close the dialog box.

CLEAR LINKS

gangs |
Coalesce Groups... 
guspend Groups

Clear groups
Clear Links
|glear Groups • Links]

This command allows you to delete all Links currently in use.

T O  C L E A R  L IN K S :

1. Select Clear Links from the Gangs menu.

2. A dialog box will appear asking to verify your request.

3. Selecting OK will dear all Links and close the dialog box.

CLEAR GROUPS 
AND LINKS

gangs
Coalesce Groups... 
guspend Groups

Clear groups 
Clear Links
Clear Croups & Links

This command allows you to delete all Groups and Links in use at 
the same time.

T O  C L E A R  G R O U P S  A N D  L IN K S :

1. Select Clear Goups and Links from the Gangs menu.

2. A dialog box will appear asking you to verify your request.

3. Selecting OK will clear all Groups and Links and close the 
dialog box.
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HELP MENU

FLV1NG FADERS
Systen flix flptions Iransport Lists gangs

MAR

YIN
by MAR

Undo F11

£eneral Info... 
Help With jtenus 
Hide Help Window

F12

Project:
Title:

Labels
Preu:------  J--- 1---F

next: —  — : — ;— ;■

Locate Tines_______
Play Fro n :------  J--- J---J.

11• •11• •11 
• •1111• •*G

LO+J

Safety Nets L20ecr?o1 [(Capture Rollback Cycle Locate » > ll
i L H n M s a Glide Tines Mix Pass Off Stop

i o n T rim
Auto: | 
Hatch: |

Play: *| £  

Rec: ___  ___ 00:00:00:00
The *Help1a putl-down menu is found on the menu beur focated at the top of the main Hying Feders screen.
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UNDO

I Help* I
Undo F11

£eneral Info...F12 
Help Vith flenus 
Hide Help Window

10-4

This command allows you to reverse commands, including Undo 
itself. Undo restores a dialog box to its former state before it was 
opened, deleting any edits that were made from the time that the 
dialog box was first opened. Undo does not effect mix edits, how­
ever. Refer to the following list for dialog boxes that Undo can 
restore.

D IA L O G  B O X E S  A F F E C T E D  B Y  U N D O :
Client Information 
Select Mix/Pass 
Glide Times 
Timecode Options 
Safety Net Times 
Locate Times 
Rollback
Reel Start and End Times 
Auto Record Times 
Channel Names

T O  U N D O  A  D IA L O G  B O X :

1. Select Undo from the Help menu. If the dialog box can be 
restored by Undo, its name will follow Undo in the menu 
listing.

2. The dialog box will be restored. If Undo will not work on that 
particular dialog box, a message will appear informing you 
that there is no Undo information. Select OK to close the 
dialog box.
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GENERAL INFORMATION

Help?
Undo F11

General I n f o . . . F12
Help With Menus 
Hide Help Window

This command allows you to view a list of Flying Fader topics for 
which help is available. Help on these topics may be obtained by : 
selecting the appropriate title from the list. . r

TO SELECT GENERAL INFORMATION:
1. Press HELP on the Neve V Series keyboard, or select Gen■? 

eral Info from the Help menu.

2. Highlight the desired title and select the Help command 
button, or double click directly on the title.

3. The Help window will open, containing information on that 
particular topic.

4. Click anywhere on the Help window to close it.

General Information

LINKS
GROUPS
Special HUTO NOTCH note 
NOTCHING
Setting RECORD nodes 
REODV/SOFE/ISO 
FODER and MITE NODES 
Selectinq the PLOY Pass 1The Pass Chain 1
NIXING |
POWER ■OBOUT HELP ________ s

i i

[ Cancel ]
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HELP WITH MENUS

Help!_ _ _ _ _ _ _ _ _ _
Undo F11

General Info...F12
Help With Menus

|Hide Help Window |

This command opens and closes the Help window. Each time a 
command is highlighted or chosen, facts and instructions about 
that command are displayed in this window.

T O  O P E N  T H E  H E L P  W IN D O W :

1. Select Help With Menus from the Help menu.

2. The window will open and a check will appear in front of the 
command, indicating that the window is enabled.

T O  C L O S E  T H E  H E LP  W IN D O W :

1. Select Help With Menus from the Help menu.

2. The window will close and the check by the command will 
disappear, indicating that the Help window is disabled.

HIDE HELP WINDOW

Help!_ _ _ _ _ _ _ _ _ _
Undo F11

general Info_ F12
Help Vith fteniis
Hide Help Window

This command allows you to conceal the Help window. Hide Help 
Window does not close the window permanently, but simply masks 
it until a new command is chosen or highlighted.

T O  H ID E  T H E  H E L P  W IN D O W :

1. Select Hide Help Window from the Help menu, or click di­
rectly on the blue text area of the window.

R E S IZ IN G  A N D  M O V IN G  T H E  H E L P  W IN D O W

The Help window appears at the bottom of the screen when 
opened, but it may be resized and relocated to any area of the 
screen.

T O  R E S IZ E  T H E  H E LP  W IN D O W :

1. Position the pointer over the border you wish to move.

2. When the pointer turns into a double-headed arrow, Click 
and Drag the border to the desired location.
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T O  M O V E  T H E  H E LP  W IN D O W :

1. Position the pointer in the white area containing the Help 
Menu title.

2. Click and Drag the window to the desired location.
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A rro w ..........................A pointer shape that is used for the selection of functions.

Auto Match................ When the fader automatically moves back to its original Pass position
after a change was made to the fader. Auto Match Glide times are ad­
justable.

Check b o x ...................Small squares that are used to select one or more options in a dialog
box.

C lic k ............................ To press and release the mouse button.

Command................... A word or phrase, usually found in a menu, that is chosen to carry out
an action.

Accelerator keys..... Special keys that execute a command or open a dialog box without
using the menu, the mouse, or a series of keystrokes.

Command button .... Rectangular buttons with rounded corners that are used to activate or
cancel a command.

Control box .............. Thesmallboxthatislocatedintheupperleft corner of the main screen.

D e fa u lt......................... An option or command that is automatically chosen by the system.
The default can be overridden by selecting the desired command or 
option.

D e le te ........................ To erase mix information from a floppy or the hard disk, or remove a
Label from a list, mutes from a list, etc..

Diagnostics window.. This window bypasses the Windows environment so you can commu­
nicate directly with the PC.

Dialog box ........*.......A box that appears when more information is needed before a
command can be carried out.

Direct window
access ...................... Control of commands and features from the main Flying Faders

screen as opposed to opening a dialog box.

DOS .......................... Disk operating system.

Double c lick ...............Quickly click the mouse button twice.

D ra g ............................ To click and hold the mouse button while moving the mouse.
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•F ioppyttJsk.............. The 3.5 inch high density disk that is used to store mix data on.
'-a yr- -!.

Form at..................__To prepare a disk so that it can hold mix information.

Gang ...........................  A Group or a Link.

Glide T im e ......._____  The amount of time (in frames) it takes to perform a Match or Auto
Match.

OJG3 ari; r*s;i ■*.< no re ut >
Global .... .... Affects all faders and mutes.

{3tabalM aster il...... .. The control panel on the console that controls certain features such as
Trim for all faders, Group and Link mode selection and interrogation, 
RSI modes for all faders, and control of automation.

G roup........................ A series of faders or mutes that are connected together with one fader
bsr. -fe t v v  c or mute serving as a master.

Group Coalesce ..—  Copying information from a Group master to that master’s slaves.

Hard d is k .................. The disk that is permanently installed in the computer. Most systems
eonsriae is rs  v. y  q -are equipped with a 40 Mb hard disk.

■ ' -;. . n

Help w in d o w ............ This window displays information and instructions about different
commands.

Hourglass ................ A pointer shape that tells you a fynction is being executed.

I-b e a m ........................  A pointer shape that is used for entering text.

Inactive command
button ...................  Command buttons that are grayed out, meaning that they are inactive

and unusable at that time.
Yr:’:' ,■
Insertion point __.... The location where text will be inserted when typed in. The insertion
aiedrr;* j<t e 1 t point is to the left of the flashing vertical line in a text box area.

Interrogation by
B E L E C T T D e t e r m i n i n g  fader master and slave relationships in a Group by using

the SELECT buttons.

TlhterTogattoftby
touch ......_______ ..... Determining fader master and slave relationships in a Group by touch­

ing the faders.
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A rro w ..........................A pointer shape that is used for the selection of functions.

Auto Match ________When the fader automatically moves back to its original Pass position
after a change was made to the fader. Auto Match Glide times are ad­
justable.

Check b o x ................. Small squares that are used to select one or more options in a dialog
box.

C lic k ............................ To press and release the mouse button.

Command................... A word or phrase, usually found in a menu, that is chosen to carry out
an action.

Command button .... Rectangular buttons with rounded comers that are used to activate or
cancel a command.

Control box .............. The small boxthat is located in the upper left corner of the main screen.

D e fa u lt........................An option or command that is automatically chosen by the system.
The default can be overridden by selecting the desired command or 
option.

D ele te ........................ To erase mix information from a floppy or the hard disk, or remove a
Label from a list, mutes from a list, etc..

Diagnostics window.. This window bypasses the Windows environment so you can commu­
nicate directly with the PC.

Dialog b o x ........ ........ A box that appears when more information is needed before a
command can be carried out.

Direct window
a c c e s s ........................Control of commands and features from the main Flying Faders

screen as opposed to opening a dialog box.

DOS ............................ Disk operating system.

Double c lick .............. Quickly click the mouse button twice.

Drag .......................... To click and hold the mouse button while moving the mouse.

Accelerator k e y e ......Special keys that execute a command or open a dialog box without
using the menu, the mouse, or a series of keystrokes.
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Neve V Series
. ^ keyboard ^.,,.,rt.„.,>̂ r  The computer keyboard that is installed on Neve consoles. It is

basically the same as tfi£standard keyboard, but contains pre>labeled 
accelerator keys and transport control keys.

Option button .......... A circular button that is used to select an option in a dialog box.
V.” ■■ *

Pointer arrow ............ A small symbol that indicates what part of the screen will be affected
when the pointer button is clicked.

An initial snapshot of all fader positions and mute states.

R A M ..........................   random access memory

Ready m o d e ............. Faders and mutes that are in the Ready Record mode will play back
and record all moves or mutes when automation is on.

Record Lock ............ A fader and mute Ready mode.

R ollback.................... When activated, the transport will rewind a user-selectable rewind
time and transfer into play.

R S I............................ Ready/Safe/lsolate (See individual definitions for each.)

Safe m o d e................ Moves and events are played back, but no moves or events can be
recorded.

Safety Nets .............. Allows you to make changes between two points in timecode while the
rest of the mix is placed in Safe.

Scroll b a r.................. A bar that appears atthe right side and/or bottom of a window or dialog
box that contains arrows on both ends. The scroll bar allows you to 
view text or items that will not fit in the box.

S elect........................ To perform an action that activates a command.

Smart keys .............. User-programmable keys. A command or series of commands may
be recorded and assigned to one of 12 Smart keys.

Standard keyboard.. The standard QWERTY keyboard for Flying Faders. Replaced with
the Neve keyboard.

Text bo x.................... Where information is inserted by the user. Text boxes are usually
located in dialog boxes.

1 - »» • 
ff* x» V■.-I :

USERS MANUAL-CHAPTER ELEVEN



Isolate m o d e .......... .. Faders and mutes that are in the Isolate mode are cufcttfftfmea'Itbe 
computer and will not play back or record any moves or mutes.

-■ r>r ...... ....... ..... iS.Tfr”Ji
K eep .......................... .. To store a mix to disk.

.........— . ...... onsQ
Keystroke................ .. A combination of key presses that carry out a command.

. .... ....... ifr iT a b ’ia
Latching button 
operatio n ................. .. A feature used for Solo. In this mode, Solo will turn on when the SOLO 

button is pressed and will turn off when pressed again..... lacoiG

Link______________ .. A series of faders or mutes that are connected together:. 
mute in the Link can serve as a master.

L is tb o x ___........__.. Contains choices that are available to the user.

L o a d _____________ .. To duplicate mix information from hard disk or floppy disk and place 
it in RAM.

Main screen .............,
...... IC-r'IEdO qud'it)

.. The master control window for Flying Faders.
............. ... , - V:T?H

Match ..._____ ......... .. When the fader moves back to its original Pass position after a change 
was made to the fader. Match Glide times are adjustable.

M enu.......................... ,
■„■■■ • - ... tt/aH 

.. A list of commands or dialog boxes.

M e n u b a r................. .. The horizontal bar across the top of the main screen thaLcontains 
menu titles.

Menu t it le ......___.... .. The list of menus contained in the menu bar.

M ix/Pass.....__ _____
ev;5t?sr*i'

.. The chain of moves and events stored in RAM. nc . r jd

Mix/Pass counter.... .. The area on the main screen that shows the current Mix/Pass number.

Mix/Pass Tree ........
;• ■ ’ .......  miocs noineani

.. A visual representation showing the hierarchy of Mix/Pass numbers.

Momentary button 
o p eratio n________

■n niJiPro'nem?
.. A feature used forvSolo. In this mode, Solo will be on only $$1qngi3p 

the SOLO button is held down. > :

M ouse...........______.. A pointing device that is used to perform functions \^gu*yth§ fjs&gf 
the keyboard. ........ I . . '  J ’ 1  d s jo t
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gv&i'tsS V &V0H
Text pag es ................ A  word processor jk) Flying Fadersthat is used-fbr*editin§lf^^

making generalises . — , -v ,

Timecode fie ld .......... The area that contains timecode numbers.
■ 4. „ fsOijtaOi ; j. : ■; ■

Touch Record ____A fader and mute Ready mode.
,. . r /  . ____  T

Trim .......................... To change the preset of afader or faders.
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